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Abstrakt 

Hlavním cílem této práce je návrh plánu společných zařízení v rámci procesu 

komplexních pozemkových úprav. Katastrální území Semice nad Labem je čistě 

polní, intenzivně zemědělsky využívanou krajinou s velkými půdními bloky. Na území 

se nachází dostatečně hustá cestní síť, řada vodohospodářských prvků ovlivňujících 

odtokový režim krajiny a nedostatečné množství interakčních prvků zajišťujících vyšší 

ekologickou stabilitu. Podrobný rozbor současného stavu lokality se zakládá na 

fotodokumentaci lokality a grafickém zaznamenání všech výše zmíněných krajinných 

prvků v mapových výstupech, při jejichž vytváření bylo k provedení krajinných analýz 

využito prostředí geografického informačního systému. Na základě rozboru 

současného stavu pak byla navržena opatření pro zvýšení prostupnosti krajiny 

a opatření k ochraně půdního fondu a životního prostředí. 

Výsledkem práce je navržení rekonstrukcí polních cest a jejich doprovodných objektů 

jako jsou propustky nebo svodné příkopy, dále navržení zatravnění a doprovodné 

zeleně polních cest, které splňují jak funkci ekologickou v podobě interakčního prvku, 

tak půdoochrannou. Je projektováno vytvoření malé vodní nádrže na Semickém 

potoce, aby se zpomalil odtok vody z krajiny a zároveň se zvýšila ekologická stabilita. 

Z důvodu nevyhovující současné trasy ÚSES je na základě územního plánu navržena 

změna trasy biokoridoru. 

Tato diplomová práce může sloužit jako podklad pro návrh společných zařízení 

v rámci zahájeného procesu komplexních pozemkových úprav v k. ú. Semice nad 

Labem. 

Klíčová slova: krajinné analýzy; polní cestní síť; protierozní opatření; 

vodohospodářská opatření; ÚSES 

  



 

Abstract 

The main goal of this thesis is to design the plan of common facilities of land 

consolidation in the area of Semice village. The cadastral territory Semice nad Labem 

is purely rural agricultural area intensively used for growing crops with a typically large 

size of the individual farmland areas. In the locality there is a sufficiently dense road 

network, several manmade water management elements affecting the runoff regime 

of the landscape and an insufficient number of interactive elements that would ensure 

higher ecological stability. The detailed analysis of the current state of the site is based 

on a photo documentation and a graphical recording of all the above-mentioned 

landscape features in map outputs. The map outputs were created based on the 

landscape analysis measurements within the geographic information system. Based 

on the analysis of the current situation, corrective measures were proposed to 

increase the permeability of the landscape and other measures to protect the soil fund 

and the environment. 

The result of this thesis is a proposal of reconstructions of field roads and their 

accompanying objects such as culverts or ditches, as well as a design of new grassing 

and avenues of trees, shrubs and other greens not only by the field roads, which fulfil 

both the ecological function in the form of an interactive element and the soil 

protection function. The project suggests a creation of a small water reservoir on the 

Semický brook in order to slow down the outflow of water from the landscape while 

increasing ecological stability. Due to the unsatisfactory route of the bio corridor in the 

current local system of ecological stability, it is proposed to change its route based on 

the land use plan. 

This diploma thesis can serve as a basis for the design of common facilities within the 

running process of complex land consolidation in the cadastral district of Semice nad 

Labem. 

Keywords: landscape analysis, field road network, erosion control measures; water 

management measures; system of ecological stability 
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1. Úvod 

Majoritní podíl krajiny v centrální Evropě tvoří krajina kulturní. Zatímco některé lidské 

aktivity zanechávají na krajině jen krátkodobé stopy, jiné zůstávají viditelné po dobu 

několika generací (Hersperger & Bürgi 2009). 

Dnešní zemědělská krajina České republiky je obrazem intenzivního hospodaření 

v druhé polovině 20. století, kdy byla vystavena zásadním zásahům člověka. 

Politickou ideologií vedené vyvlastňování půdy a kolektivizace zemědělství absolutně 

potlačily vazbu člověka k obdělávané krajině a vyloučily osobní zodpovědnost 

jednotlivce za její stav a podobu (Hájek 2008). Došlo k vytvoření velkých bloků orné 

půdy za účelem usnadnění pojezdu mechanizace na úkor liniových prvků v krajině; 

docházelo k rozorávání mezí, rušení polních cest a kácení remízků a alejí. Pro 

zvýšení výnosnosti půdy byly na mnoha místech republiky nainstalovány meliorační 

systémy, které měly za úkol zavlažit nebo naopak odvodnit půdu. Kvůli nešetrnému a 

neuváženému zacházení s těmito a dalšími hydrologickými opatřeními došlo 

k narušení přirozeného vodního režimu krajiny, byly narovnávány toky, odvodňovaly 

se mokřady, a tak se zásadně snížila retenční schopnost půdy. Důsledkem výše 

zmíněných změn ve způsobu obhospodařování půdy bylo vymizení některých 

živočišných a rostlinných druhů a celková degradace půdy a krajiny. 

Jedním z nejúčinnějších nástrojů krajinného plánování, který pomáhá se s tímto 

dědictvím z minulosti vypořádat, jsou komplexní pozemkové úpravy, především návrh 

společných zařízení. Díky narovnání často složitých vlastnických vztahů a realizování 

společných zařízení dochází k obnovení zanedbané a poničené krajiny. Mezi 

nejčastěji navrhovaná společná zařízení patří revitalizace stávajících či navrhování 

nových polních cest, mostků, odvodňovacích příkopů, stavba poldrů a údržba vodních 

toků, zatravnění údolnic na erozně ohrožených pozemcích nebo výsadba alejí a další 

zeleně pro zlepšení prostupnosti krajiny pro živočichy (MZe 2012). 

V takto „ozdravené“ krajině je voda přirozeně zadržována na pozemcích díky 

zpomalení jejího odtoku z místa a zlepšené zasakovací schopnosti půdy. Díky 

vhodně umístěným polním cestám doprovozených alejemi ovocných stromů 

a četnými mezemi přirozeně dělících plochu na menší políčka je omezeno působení 

erozních faktorů. Obnovení remízků a mokřadních ekosystémů pomáhá do krajiny 

navrátit ohrožené druhy rostlin a živočichů. 
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2. Cíle práce 

Hlavním cílem práce je návrh plánu společných zařízení komplexních pozemkových 

úprav v katastrálním území Semice.  

Dílčí cíle práce jsou následující: 

• Sepsání literární rešerše zaměřené na zpracování pozemkových úprav 

v České republice, plán společných zařízení a krajinné analýzy.  

 

• Rozbor současného stavu lokality s využitím krajinných analýz v prostředí 

geografických informačních systémů, terénní průzkum a rešerše 

biogeografických podmínek lokality. 

Výstupy mohou v budoucnu sloužit jako návrh plánu společných zařízení komplexní 

pozemkové úpravy k. ú. Semice.  
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3. Literární rešerše 

3.1  Pozemkové úpravy 

Pozemkové úpravy jsou dle § 2 zákona č. 139/2002 Sb., o pozemkových úpravách a 

pozemkových úřadech a o změně zákona č. 229/1991 Sb., o úpravě vlastnických 

vztahů k půdě a jinému zemědělskému majetku, ve znění pozdějších předpisů (dále 

jen "zákon o pozemkových úpravách"), takové změny pozemků, jimiž „se ve veřejném 

zájmu prostorově a funkčně uspořádávají pozemky, scelují se nebo dělí 

a zabezpečuje se jimi přístupnost a využití pozemků a vyrovnání jejich hranic tak, aby 

se vytvořily podmínky pro racionální hospodaření vlastníků půdy. V těchto 

souvislostech se k nim uspořádávají vlastnická práva a s nimi související věcná 

břemena. Výsledky pozemkových úprav slouží pro obnovu katastrálního operátu 

a jako neopomenutelný podklad pro územní plánování.“  

Výše uvedeným veřejným zájmem je míněno, že procesu pozemkových úprav se 

dnes také využívá k návrhu plánu společných zařízení, tzn. veřejně prospěšných 

opatření a staveb sloužících ke zpřístupnění pozemků, ochranných opatření před 

erozí půdy či povodněmi nebo suchem a také opatření zajišťující celkovou ochrannou 

a tvůrčí funkci krajiny z hlediska ochrany životního prostředí. V takto navržené síti se 

následně upravují vlastnické vztahy soukromých pozemků tak, aby se zlepšila jejich 

dispozice a možnost obhospodařování (Vlasák & Bartošková 2007; Burian et al. 

2011). 

Krajina v České republice byla zejména v poválečném období 20. století vystavena 

zásadním zásahům člověka, a tak i pozemkové úpravy se dnes hlavně vypořádávají 

s vlivy hospodaření a politiky minulých let (Burian et al. 2011). V roce 1960 bylo přes 

80 % pozemků obhospodařováno státními statky či družstvy. Vyvlastňování půdy 

absolutně potlačilo vazbu člověka k obdělávané krajině a vyloučilo osobní 

zodpovědnost za její stav a podobu (Hájek 2008). V důsledku neurovnaných 

vlastnických práv pozemků tak došlo také k tomu, že původní vlastníci a jejich parcely 

zanesené v katastru nemovitostí neodpovídají dnes skutečnému stavu (Burian et al. 

2011). 

3.1.1 Historie pozemkových úprav 

Pozemkové úpravy nejsou oborem, jenž by vznikl v historicky krátké době a pouze 

pro potřeby České republiky, aby se vypořádal s následky hospodaření v letech 

1948–1989, ale jejich historie sahá podstatně dále. 
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12. - 18. století 

Počátky evidence užívání půdy se datují až do Říše římské, kdy již docházelo 

k vytyčování pozemkových hranic a měření velikosti zemědělských pozemků 

a zeměměřiči byli zařazeni mezi orgány státní správy. V Českých zemích od 12. 

století docházelo díky růstu domácí populace k tzv. vnitřní kolonizaci. Docházelo tak 

k mýcení a vypalování lesů a úbytku pastvin, na jejichž úkor se stavěly nové vesnice. 

U takto vzniklých nových vesnic docházelo také k rozdělování zemědělského půdního 

fondu, v čemž lze spatřovat počátek pozemkových úprav u nás. Na základě 

hodnocení tehdejší organizace půdního fondu, tvaru pozemků, intenzity vytyčování 

cestní sítě a výstavby vodohospodářských opatření lze toto období považovat za 

nejdůležitější etapu vývoje pozemkových úprav až do 19. století (Toman 2006).  

V 15.-17. století následovalo z hlediska pozemkových úprav období útlumu. Druhou 

vlnou kolonizace bylo zakládání měst, do kterých se přemístily obchodní 

a řemeslnické funkce, a tak se zásadně změnila podoba vesnických sídel, ve kterých 

zůstalo obhospodařování zemědělských pozemků. Z těchto pozemků museli poddaní 

odvádět vrchnosti daň, a aby byla daň správně vyměřená, došlo v 17. století 

k vytvoření prvních odhadů velikostí pozemků, tj. prvního katastru půdy u nás, 

známého v Čechách jako první berní rula nebo na Moravě jako lánový rejstřík (Bumba 

2007). Aktualizace berní ruly v letech 1741–1748 jsou známé pod názvem 

tereziánský katastr, dle panovnice Marie Terezie. Zásadní změnu přinesl patent 

Josefa II. z roku 1785, díky kterému se za základní jednotku katastru začal považovat 

pozemek, který byl skutečně zaměřen v terénu, nikoliv pouze odhadnut pro účely 

výběru daní. Lze ho označit za první kompletní pozemkový katastr v Českých zemích, 

jelikož do něj byl zahrnut nejen rustikál, ale i dominikál, tedy půda vlastněná nejen 

poddanými, ale také vrchností. Rozdíly ve výměrách oproti tereziánskému katastru 

někde dosahovaly až 60 %, a tak mnohdy šlechta odváděla mnohonásobně vyšší 

daň. Proto byl v roce 1792 vytvořen jakýsi kompromis, tereziánsko-josefský katastr, 

který si přenesl přesnost měření josefského katastru a stejné zdanění dominikálu i 

rustikálu, ale zároveň byly daně odváděny dle odhadu ocenění podle tereziánského 

katastru (Bumba 2007; Vlasák & Bartošková 2007; Burian et al. 2011; Mazín 2014). 

19. století 

V roce 1860 byl představen tzv. stabilní katastr. Z hlediska pozemkových úprav 

nepatřilo toto období k těm nejšťastnějším, na základě zrušení nevolnictví v roce 

1849 se půda stala významným obchodním artiklem, a tak byly poprvé výrazně 

zpřetrhány vztahy člověka k obdělávané půdě. Docházelo k velké fragmentaci 
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pozemků, kdy se díky zadluženosti, dědictví, věnu při svatbě a dalších 

majetkoprávních aktech lány dělily na menší plochy a měnily majitele. Nemenší podíl 

na fragmentaci krajiny měl rozvoj komunikací, železnic, ale i vodohospodářských děl 

(Toman 2006). Stabilní katastr tak vznikl díky vyšší poptávce po přesnosti měření 

v souvislosti s intenzivnějším obhospodařováním půdy, s nárůstem obchodování 

s pozemky a s tím spojeným růstem cen a v neposlední řadě poptávce po přesnosti 

a spravedlivosti daňového výměru. Mapování probíhalo v letech 1817–1861, kdy 

použité mapové měřítko bylo dnes nezvyklých 1:2880 z důvodu tehdy používaných 

jednotek obsahu (Bumba 2007). Součástí měření bylo také oceňování (bonitace) 

půdy, ale zejména z důvodu dlouhotrvajícího měření a různosti nahlížení znalců na 

výnosnost půdy nedosahovala tato část obecně požadovaných kvalit. Proto bylo 

v roce 1869 říšským zákonem rozhodnuto, že tato část katastru musí být 

přepracována. Tato úprava se nazývá reambulací stabilního katastru (Kuttner et al. 

2013). Ovšem již v roce 1871 bylo rozhodnuto o zavedení pozemkové knihy, jejíž 

zápisy o nemovitostech se musely shodovat s pozemkovým katastrem, a tak bylo 

přepracování stabilního katastru značně uspíšeno na úkor kvality. Stabilní katastr byl 

v platnosti až do roku 1927 (Burian et al. 2011; Mazín 2014). 

Z důvodu uvolnění vlastnických práv k zemědělské půdě a fragmentaci krajiny byly 

pozemky neuspořádané, rozdrobené a mnohdy nepřístupné. Zemědělec tehdy 

hospodařil v průměru na 29 pozemcích, mnohdy i v různých katastrálních územích, 

což značně komplikovalo rozvoj zemědělství (Sklenička 2003). V roce 1883 vychází 

říšský rámcový zákon o scelování hospodářských pozemků, který byl ovšem platný 

pouze pro Moravu a Slezsko; Čechy z kompetenčních důvodů říšský zákon nepřijaly, 

a tak až do roku 1940 v Čechách probíhaly pozemkové úpravy pouze na dobrovolné 

bázi se souhlasem všech účastníků. Na Moravě a ve Slezsku tak bylo provedeno 

v letech 1890–1940 scelení pozemků na území 323 obcí, v Čechách na území 2 obcí 

(Vlasák & Bartošková 2007; Burian et al. 2011). 

1918–1945 

Po rozpadu Rakouska-Uherska a vzniku Československé republiky byl zřízen 

pozemkový úřad a vznikl přídělový zákon č. 81/1920 Sb. Rozdělení pozemků šlechty 

jednotlivcům či sdružením a jiným právnickým osobám znamenalo zásadní reformu 

v oblasti vlastnických vztahů a vytvořila se zcela nová struktura vlastnictví půdy. 

V meziválečném období v roce 1927 vznikl nový zákon o pozemkovém katastru. 

Poprvé byl jasně vymezen rozdíl mezi pozemkem a parcelou. Bylo také zavedeno 

nové Křovákovo zobrazení a S-JTSK souřadnicový systém. Při obnovování 
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pozemkového katastru se začala využívat metrická měřítka, nejčastěji 1:2000. 

V katastrální mapě jsou nově rozdělena jednotlivá katastrální území (Bumba 2007; 

Vlasák & Bartošková 2007; Burian et al. 2011). 

1945–1989 

Dalším historicky významným zásahem do vlastnictví půdy došlo po 2. světové válce 

na základě tzv. Benešových dekretů, kdy byl zemědělský majetek německého 

obyvatelstva rozdělen nově ustanoveným národním pozemkovým fondem mezi 

fyzické osoby, zemědělská družstva a orgány státní správy a samosprávy. V roce 

1948 vznikla nová pozemková reforma připravující podmínky pro kolektivizaci 

zemědělství (Vlasák & Bartošková 2007). V roce 1949 byl přijat zákon o jednotných 

zemědělských družstvech (JZD), který měl co nejrychleji zavést tzv. socialistickou 

zemědělskou výrobu. Díky politizaci přístupu k zemědělství a vyvlastňování pozemků 

ve prospěch socialistického státu docházelo k rozsáhlým a rychlým přeměnám ve 

vlastnických vztazích, které nebylo možné všechny zachytit v dosavadní evidenci 

(Sádlo et al. 2005). Tak v roce 1956 vznikla jednotná evidence půdy, kde byly 

evidovány pouze uživatelské vztahy bez ohledu na vlastnictví pozemku (Burian et al. 

2011). 

Vzhled a vývoj krajiny v České republice byl nejvíce ovlivněn scelováním pozemků za 

účelem intenzifikace zemědělství. Scelování vedlo k ekologické devastaci venkova, 

jelikož byl ovlivněn výskyt rostlinných i živočišných druhů, vlhkost půdy či odolnost 

půdy proti větrné či vodní erozi. Centrální plánování zemědělství mělo za následek 

vytvoření monokultur hospodářsky výnosných plodin. Jednoznačně neudržitelné 

zohledňování ekonomických zájmů nad ekologickými zhoršilo kvalitu pozemků. 

Všechna tato výše zmíněná opatření, přes nezpochybnitelný hospodářský přínos, 

byla citelným narušením venkovských oblastí a jejich struktury (Hájek 2008). 

Pozemkové úpravy v období 1950–1960 řešily hlavně vznik JZD a přesun důrazu 

z technických na politické otázky. Pozemkové úpravy jsou v té době přejmenovány 

na hospodářsko-technické úpravy pozemků (Toman 2006). Měnily se majetkové 

poměry, ale JZD byla budována ve stávající síti společných zařízení. Od roku 1960 

byla již JZD stabilizovaná, a tak bylo možné přejít ke slučování jednotlivých JZD na 

celky s výměrou do 1000 ha. Tyto pozemkové úpravy již zahrnovaly také návrhy na 

reorganizaci společných zařízení a akcentovaly hospodářské využití zemědělské 

půdy, tj. i velikost navrhovaných ploch. Tato etapa trvala až do rou 1972 a dala obraz 

české krajině, jak ji převážně známe dnes. Po roce 1974 byly vypracovány generely 

pozemkových úprav které plánovaly slučování zemědělských družstev na pozemky o 
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velikosti několika tisíc hektarů za účelem jednoduchého použití mechanizace a 

maximalizace výnosů (Burian et al. 2011; Mazín 2014). 

1989–2017 

Díky politickým změnám po roce 1989 se znovu navrátila nadřazenost vlastnických 

vztahů nad ty uživatelské. Na základě zákona č. 569/1991 Sb. byl založen 

Pozemkový fond České republiky, který měl na starost postupnou privatizaci státních 

pozemků a vydávání původních či náhradních pozemků v restitucích. Na úrovni 

okresních úřadů působily pozemkové úřady, nejdříve pod hlavičkou ministerstva 

vnitra. Také se obnovil proces pozemkových úprav, který byl vzhledem k politickým 

událostem dvacátého století značně utlumen. Od roku 1992 je oficiálně používán 

Katastr nemovitostí České republiky. Jeho základní jednotkou je katastrální území a 

oficiálním referenčním systémem je S-JTSK. Veškerá projekční práce byla převedena 

na soukromníky, a státem je tak proces pozemkových úprav pouze řízen. V 90. letech 

docházelo hlavně k provádění k jednoduchých pozemkových úprav, aby se co 

nejrychleji vyřešily problémy při navracení půdy soukromníkům. Přesto byly první 

komplexní pozemkové úpravy dokončeny již v roce 1994 (Burian et al. 2011; Mazín 

2014). Období kolem roku 2000 se neslo ve znamení příprav na vstup České 

republiky do Evropské unie. Vzniká zákon č. 139/2002 Sb., o pozemkových úpravách 

a pozemkových úřadech a o změně zákona č. 229/1991 Sb., o úpravě vlastnických 

vztahů k půdě a jinému zemědělskému majetku. Při rušení okresů v roce 2003 byla 

agenda pozemkových úřadů převedena pod hlavičku ministerstva zemědělství, ale 

místní pobočky zůstaly zachovány (Mazín 2014). V roce 2007 pak bylo rozhodnuto, 

že je třeba organizaci restrukturalizovat, aby byl úřad schopen lépe reagovat na 

vyvíjející se potřeby trhu, a tak v roce 2009 došlo k nastolení struktury úřadu, jak ji 

známe dnes. V roce 2013 byl uzákoněn státní pozemkový úřad – ústřední orgán 

v rámci pozemkových úprav, jenž má 14 krajských pozemkových úřadů a 65 poboček 

na úrovni původních okresů; tato struktura plně nahradila Pozemkový fond České 

republiky a místní struktury pozemkových úřadů (Mazín 2014; SPÚ 2017).  

3.1.2 Předmět a obvod pozemkových úprav 

Předmětem pozemkových úprav jsou všechny pozemky ve vymezeném obvodu bez 

ohledu na dosavadní vlastnické a uživatelské vztahy nebo způsob využívání. Obvod 

je zpravidla omezen hranicemi katastrálního území, ale je-li to z důvodu dosažení 

lepších výsledků výhodné, lze zahrnou do obvodu i pozemky ze sousedních 

katastrálních území (zákon 139/2002 Sb. 2002; Vlasák & Bartošková 2007). Dle 

zákona 139/2002 Sb. je pro určitá specifická území třeba před jejich zahrnutím do 
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pozemkových úprav souhlasu jejich vlastníka, případně i příslušného správního úřadu 

(Tabulka 1). 

Druh pozemku Potřebný 

souhlas 

vlastníka 

Potřebný 

souhlas 

správního 

úřadu 

Pozemek určený pro obranu státu x x 

Těžba nerostů x x 

Pozemek zastavěný stavbou ve vlastnictví státu x x 

Vodní toky x x 

Pozemky chráněné podle zvláštních předpisů x x 

Pozemek zastavěný stavbou, která není ve vlastnictví státu x  

Pozemek funkčně související se stavbou (cesta, zahrada) x  

Hřbitovy x  

Pozemek v zastavěném území a v zastavitelných plochách x  

Tabulka 1 Potřebný souhlas pro zahájení PÚ (zákon 139/2002 Sb.) 

Pozemky ve vlastnictví státu, které byly původně ve vlastnictví církve se nepoužijí pro 

výstavbu společných zařízení, ale jinak s nimi lze nakládat jako s běžným státním 

pozemkem. Pokud se vlastníci nevyjádří v době stanovené pozemkovým úřadem, 

přepokládá se, že se zahrnutím do pozemkových úprav souhlasí. 

3.1.3 Cíle a formy pozemkových úprav 

Hlavním cílem pozemkových úprav je racionální uspořádání vlastnických vztahů 

k zemědělským a lesním pozemkům s ohledem na potřeby krajiny a následné 

vytvoření nového uspořádání pozemků tak, aby bylo možné řádně pozemky užívat, 

ale také plnit vlastnické závazky a povinnosti. Snahou je docílit obnovení osobního 

vztahu lidí k zemědělské půdě a krajině, jako tomu bylo v předválečném období 

a napomoci rozvoji trhu s půdou s využitím pro zemědělství (Batysta et al. 2014). 

Dané území je řešeno jako celek, kdy se ve veřejném zájmu scelují nebo dělí 

pozemky a zabezpečuje se jejich přístupnost a využití, vyrovnávají se hranice 

a zabezpečují se dobré podmínky pro hospodaření vlastníků půdy (zákon 

139/2002 Sb.). V těchto souvislostech původní pozemky zanikají a zároveň se 

vytvářejí pozemky nové, k nimž se uspořádávají vlastnická práva a související věcná 

břemena. Výsledky pozemkových úprav tak také slouží pro obnovu dat katastrálního 

operátu a k digitalizaci katastrální mapy (Batysta et al. 2014).  
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V neposlední řadě se pomocí návrhu společných zařízení zajišťují podmínky pro 

zlepšení kvality života ve venkovských oblastech. Společná zařízení napomáhají 

ke zlepšení kvality životního prostředí, ochraně a zúrodnění půdního fondu, snižování 

nepříznivých účinků povodní a řešení problematických odtokových poměrů v krajině 

a zvýšení ekologické stability krajiny (Sklenička 2006; Mazín 2014). 

Dle § 4 zákona č. 139/2002 Sb. v platném znění jsou ustanoveny dvě formy 

pozemkových úprav – jednoduché a komplexní. Jednoduché pozemkové úpravy 

představují řešení jen části jednoho katastrálního území, respektive pouze v něm 

vybraného problému, případně jejich prostřednictvím bývá provedena rekonstrukce 

nebo upřesnění přídělů půdy dle § 13 daného zákona. Oproti tomu komplexní 

pozemkové úpravy představují ucelené řešení zpravidla celého katastrálního území 

(mimo intravilán) včetně povinného návrhu společných zařízení. Komplexní 

pozemkové úpravy jsou díky celistvému řešení jednoho katastrálního území 

s návazností na své okolí častěji využívanou variantou. 

3.1.4 Průběh řízení pozemkových úprav 

Zahájení řízení 

Celý průběh řízení pozemkových úprav je upraven druhou částí zákona 139/2002 Sb., 

v platném znění (§ 6–17). Řízení pozemkových úprav se vždy považuje za zahájené 

pouze pozemkovým úřadem, přestože podnět k pozemkovým úpravám může podat 

kdokoliv. Po obdržení podnětu pozemkový úřad zváží jeho účelnost a naléhavost, a 

pokud shledá důvody jako opodstatněné, zahájí řízení o pozemkových úpravách. 

V odůvodněných případech můžou být pozemkové úpravy zahájeny i bez podaných 

podnětů. V případě, že se pro zahájení pozemkových úprav vysloví nadpoloviční 

většina vlastníků výměry zemědělských pozemků v dotčeném katastrálním území, je 

pozemkový úřad povinen zahájit řízení vždy. Oznámení o zahájení řízení se po dobu 

15 dnů vyvěsí na úřední desce pozemkového úřadu a dotčených obcí. Řízení se 

považuje za zahájené posledním dnem této lhůty. 

Účastníci řízení 

Účastníky řízení jsou dle § 5 zákona 139/2002 Sb., v platném znění, všichni vlastníci 

pozemků, které jsou předmětem pozemkových úprav. V případě, že vlastník zemře 

a soud ještě pravomocně nerozhodl o dědictví, je soudem určen dočasný zástupce. 

Pokud se soud nevyjádří v době stanovené pozemkovým úřadem, je ustanoven 

tzv. opatrovník, kterým může být i obec. Dalším účastníkem je stavebník, je-li proces 

pozemkových úprav vyvolán v důsledku investičního záměru, jako je třeba výstavba 
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dálnic nebo průmyslových zón. Posledním účastníkem řízení jsou obce, které jsou 

pozemkovými úpravami přímo dotčené nebo i obce, které s dotčenými pozemky 

sousedí, pokud se do 30 dnů od výzvy pozemkového úřadu do řízení zapojí. 

Úvodní jednání (§ 7) 

Všichni účastníci řízení jsou pozemkovým úřadem o zahájení řízení vyrozuměni. 

Pozemkový úřad poté svolá úvodní jednání, na který pozve všechny účastníky řízení, 

seznámí je s formou, účelem a předpokládaným obvodem úprav. Vlastníci si během 

úvodního jednání volí sbor zástupců, který v dalším řízení všechny další dotčené 

vlastníky zastupuje. Členem sboru se může stát každý vlastník, kterému patří alespoň 

10 % z celkové výměry pozemků dotčených pozemkovými úpravami. Velikost sboru 

je určená pozemkovým úřadem dle celkového počtu vlastníků v rozsahu 5 až 15 

členů, vždy v lichém počtu. Nevoleným členem sboru je také zástupce pozemkového 

úřadu a zástupce obce. Sbor si následně zvolí předsedu, který svolává schůze a řídí 

jejich průběh. 

Soupis a ocenění nároků vlastníků (§ 8) 

Pozemkový úřad je zodpovědný za vypracování soupisu nároků vlastníků pozemků, 

který obsahuje jejich cenu, výměru, vzdálenost (obvykle od středu obce – určeno při 

úvodním jednání) a druh, včetně všech omezení v jejich využití vyplývajících ze 

zástavního či předkupního práva nebo věcného břemene. Základem pro oceňování 

zemědělské půdy jsou bonitované půdně ekologické jednotky (BPEJ), které vyjadřují 

hlavní půdní a klimatické podmínky ovlivňující produkční schopnost půdy, a tím 

pádem i ekonomické ohodnocení pozemku. Soupis je po dobu 15 dní vystaven na 

úřední desce obecního úřadu a je doručen vlastníkům pozemků. Ti mají možnost proti 

soupisu podat námitku, kterou se pozemkový úřad společně se sborem musí zabývat. 

Vlastníci následně musejí být o vyřízení námitek písemně vyrozuměni.  

Návrh pozemkových úprav (§ 9) 

Dalším krokem v řízení je návrh nového uspořádání pozemků. Návrh může být 

zpracován pouze fyzickou osobou, která má úřední oprávnění o odborné způsobilosti 

k projektování pozemkových úprav. Pro účely vypracování návrhu dochází 

k zaměření skutečného stavu hranic pozemků v terénu, kterému je přítomna komise 

složená z pracovníků pozemkového a katastrálního úřadu, zpracovatele návrhu 

a zástupců obcí a dle potřeby i dalších úřadů. Tímto zaměřením je definitivně určen 

obvod pozemkových úprav a účastníci řízení. Před vytvořením samotného návrhu 

dochází k vypracování plánu společných zařízení, který musí být do schválení návrhu 
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předložen pozemkovým úřadem ke schválení zastupitelstvem obce a musí s ním být 

seznámen také sbor vlastníků. Společná zařízení se přednostně navrhují na státních, 

případně obecních pozemcích, ale v rámci veřejného zájmu může být vlastníkem 

i jiná osoba. Pokud je takto dotčený pozemek ve vlastnictví státu, může být po 

dokončení pozemkových úprav bezplatně převeden obci. Plán společných zařízení 

musí být v souladu s územně plánovací dokumentací.  

Přiměřenost kvality, výměry a vzdálenosti původních a navrhovaných 

pozemků (§ 10) 

Nové uspořádání pozemků musí být v souladu s původním soupisem nároků. Nové 

pozemky musí odpovídat cenou, výměrou, vzdáleností od středu obce a v rámci 

možností také druhem pozemku. Snížení nebo zvýšení ceny, výměry či vzdálenosti 

nad přiměřenou míru lze provést pouze se souhlasem vlastníka, pokud tímto 

vlastníkem není stát. Za přiměřenou cenu se považuje rozdíl do 4 % oproti původním 

cenám pozemků. Pokud by cena překročila tuto hranici ve prospěch soukromého 

vlastníka a ten s tím souhlasil, je povinen tento rozdíl v ceně uhradit. Přiměřená 

výměra je do 10 % rozdílu a přiměřená vzdálenost do 20 % rozdílu. Návrh nového 

uspořádání pozemků musí být s vlastníky konzultován a jimi písemně odsouhlasen; 

pokud se vlastníci nevyjádří ve stanovené lhůtě 15 dnů, považuje se to za jejich 

souhlas. 

Rozhodnutí o pozemkových úpravách (§ 11) 

Zpracovaný návrh je pozemkový úřad povinen vystavit na své a obecní úřední desce 

po dobu 30 dnů a musí s ním obeznámit všechny známé účastníky řízení, pro které 

je toto poslední možnost pro uplatnění námitek. Pokud dojde na základě námitek 

k úpravám návrhu, musí se celý proces rozhodnutí opakovat. Po uplynutí 30denní 

lhůty je pozemkovým úřadem svoláno závěrečné jednání, při kterém dochází ke 

schvalování návrhu. Návrh se považuje za schválený, pokud s ním souhlasí vlastníci 

alespoň 60 % výměry pozemků. Rozhodnutí o schválení je zveřejněno ve vyhlášce 

a doručeno všem známým účastníkům a také je předáno katastrálnímu úřadu 

k zanesení. Schválený návrh je závazným podkladem pro směnu pozemků. 

Náklady na pozemkové úpravy (§ 17) 

Veškeré náklady spojené s průběhem pozemkových úprav hradí stát. V případě, že 

je proces vyvolán v důsledku stavební činnosti, pak je povinen náklady pokrýt 

stavebník. Participace dalších účastníků řízení, případně i jiných osob, je možná, 

mají-li na provedení pozemkových úprav zájem. 
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3.1.5 Náležitosti návrhu pozemkových úprav 

Náležitosti návrhu pozemkových úprav jsou specifikovány v příloze č. 1 

vyhlášky 13/2014 o postupu při provádění pozemkových úprav a náležitostech návrhu 

pozemkových úprav, v platném znění.  

Jsou jimi: 

• Průvodní list pozemkových úprav 

• Souhrnná zpráva 

• Dokumentace o přípravě řízení o pozemkových úpravách 

• Rozbor současného stavu 

• Zeměměřičské práce a dokumentace k určení obvodu pozemkových úprav 

• Dokumentace k soupisu nároků vlastníků pozemků 

• Plán společných zařízení 

• Návrh nového uspořádání pozemků 

• Ostatní grafické přílohy, které nejsou součástí plánu společných zařízení 

• Dokladová část 

3.1.6 Pozemkové úpravy v zahraničí 

Pozemkové úpravy se prováděly a provádějí prakticky ve všech vyspělých zemích, 

avšak každá země k nim přistupuje jiným způsobem, neboť je třeba jejich cíle 

přizpůsobit historickému vývoji a současnému stavu krajiny v dané zemi (Crecente et 

al. 2002; Sklenička 2006). V Evropské unii se pozemkové úpravy realizují nejvíce 

v Německu, Nizozemí, Belgii, Francii, Rakousku, Švédsku a Finsku. Státy západní 

Evropy vidí v procesu pozemkových úprav nástroj pro rozvoj regionů, vybudování 

infrastruktury a zvýšení ekologické stability krajiny, jelikož nebyly zpřetrhány 

vlastnické vazby k pozemkům; oproti tomu státy střední a východní Evropy, včetně 

České republiky, využívají pozemkových úprav z historických důvodů v první řadě pro 

vyjasnění vlastnických práv a vztahů k pozemkům, kdy se daleko více potýkají 

s faktem, že většina zemědělské půdy není obhospodařována vlastníky, ale nájemci 

(Burian et al. 2011).  

Specifickou charakteristikou států střední Evropy je poměr vlastnictví a využití půdy 

(land use); úroveň fragmentace vlastnictví pozemků je vysoká, oproti tomu míra 

fragmentace land use je naopak nízká. Velké lány zemědělské půdy se stejným 

využitím jsou pozůstatkem minulého režimu, které jsou po restitucích v 90. letech 

vlastněné mnoha vlastníky. To často majitelům nedává jinou alternativu než svou 

půdu pronajmout většímu zemědělskému družstvu. V zemích západní Evropy lze 
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pozorovat přímou úměru mezi těmito faktory – čím vyšší fragmentace vlastnictví, tím 

vyšší fragmentace land use. Nedošlo tam k tak výraznému přetrhání vztahů vlastníků 

k půdě (Trávníček et al. 2002; Hartvigsen 2013; Hartvigsen 2014). 

Zajímavostí je až nečekaná rozdílnost v procesu pozemkových úprav mezi Českou 

republikou a Slovenskem. Na Slovensku jsou v návrhu pozemkových úprav nároky 

jednotlivých vlastníků zpracovány bez závazku k původnímu vlastnickému titulu. 

V České republice se však v rámci pozemkových úprav pracuje s pojmem 

spoluvlastnictví, tedy pokud byl původní pozemek vlastněn skupinou vlastníků, 

obvykle nedochází k oddělení jednotlivých vlastníků ani po přerozdělení pozemků. 

Tento rozdílný přístup u zemí se společnou historií vyplynul z prvotních projektů 

pozemkových úprav po rozdělení Československa. Český přístup je jednodušší pro 

zpracovatele návrhu pozemkových úprav, ovšem pro urovnání vlastnických vztahů je 

podstatně zjednodušující slovenské řešení, jelikož nově navržený pozemek má pouze 

jednoho majitele, a tak se také podstatně zjednodušuje manipulace s pozemkem na 

trhu s půdou (Muchová & Jusková 2017).  
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3.2  Plán společných zařízení 

Společná zařízení jsou technická, půdoochranná, vodohospodářská a biologická 

opatření sloužící k realizaci veřejných zájmů v rámci procesu pozemkových úprav 

a ze zákona jsou součástí každého návrhu komplexních pozemkových úprav. 

(Batysta et al. 2014; Mazín 2014). Pozemkové úpravy jsou tak multidisciplinárním 

oborem a v jejich rámci je třeba zapojit odborníky nejen z oborů pozemkových úprav 

a geodézie, ale také z oborů vodohospodářství, ochrany životního prostředí, 

dopravních staveb, krajinného inženýrství a dalších (Vlasák & Bartošková 2007). 

Návrh plánu společných zařízení slouží k obnovení přirozené funkčnosti krajiny 

a odstranění negativních zásahů z minulosti (Vlasák & Bartošková 2007). 

Dle zákona č. 139/2002 Sb. jsou společná zařízení následujícího charakteru: 

• Opatření, díky kterým dojde ke zpřístupnění pozemků 

• Opatření na ochranu půdního fondu sloužící k prevenci eroze 

• Vodohospodářská opatření pro odvod povrchových vod a předcházení 

povodním 

• Opatření k ochraně a tvorbě životního prostředí 

Pro návrh společných zařízení je proces pozemkových úprav nenahraditelný. Mnohdy 

se během nich totiž vyřeší vlastnické vztahy, které by jinak bránily realizaci opatření. 

Následnou realizací společných zařízení pak také dochází k bezesporu 

nejhmatatelnějším změnám v území v rámci pozemkových úprav (Burian et al. 2011; 

MZe 2012). Zákon č. 139/2002 Sb. vymezuje, že navrhovaný plán společných 

zařízení by měl vždy být v souladu s územně plánovací dokumentací, pokud nejsou 

závažné důvody, aby tomu bylo jinak a pokud územní plán existuje. Nesoulad je 

důvodem pro změnu či aktualizaci územně plánovací dokumentace. Před 

předložením návrhu zastupitelstvu obce ke schválení je pozemkový úřad povinen 

s tímto návrhem seznámit sbor zástupců nebo vlastníky pozemků, pokud sbor není 

zvolen. Dotčené orgány státní správy a další dotčené organizace jsou s návrhem 

seznámeny a mají 30 dnů na vyjádření svého stanoviska. Primárně se společná 

zařízení navrhují na státních či obecních pozemcích. V případě, že jich v řešeném 

území není dostatečné množství, podílí se na vyčlenění pozemků také ostatní 

vlastníci, a to poměrnou částí dle celkové výměry směňovaných pozemků. Obecnou 

zásadou však je, že opatření mají být navrhována tak, aby jejich účinnost byla 

maximální při co nejmenším záboru půdy. Všechny navrhované prvky by měly mít 

polyfunkční charakter, např. větrolamy navrhované primárně jako protierozní opatření 

by měly být i funkčním biokoridorem (Vlasák & Bartošková 2007; Batysta et al. 2014). 
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3.2.1 Opatření sloužící ke zpřístupnění pozemků 

Hlavním účelem těchto opatření je zajištění přístupu k pozemkům, umožnění 

racionálního hospodaření a zvýšení propustnosti krajiny. Příkladem opatření 

sloužícího ke zpřístupnění pozemků jsou hlavně polní cesty a jejich doplňkové prvky 

jako jsou mostky, propustky nebo brody apod. Při navrhování polních cest je třeba 

zvážit jejich racionální napojení na komunikace vyšších tříd a místní komunikace, na 

cestní síť okolních katastrálních území a případně také na lesní cesty (SPÚ 2016a). 

Při návrhu je nutno se řídit platnými technickými normami a předpisy. Navrhování 

polních cest se řídí normou ČNS 73 6109 Projektování polních cest (Tabulka 2). 

Polní cesta je účelová komunikace, která slouží primárně pro pojezd zemědělské 

mechanizace, ale může mít i doplňkový význam, jako je zpřístupnění vodní plochy 

nebo turistika. Vedle hydrografické sítě se jedná o nejdůležitější liniový prvek krajiny 

a hraje zásadní roli při definování krajinného rázu. Zajímavou vlastností cestní sítě je, 

že cesty slouží ke zpřístupnění pozemků, ale na druhé straně krajinu fragmentují 

a tvoří bariéru (Vlasák & Bartošková 2007; Burian et al. 2011). V letech 1948–1989 

došlo s přechodem na kolektivní hospodaření na velkých plochách k úbytku až 70 % 

polních cest oproti původní délce, dále byly rozorány desítky tisíc kilometrů mezí 

a vykácena doprovodná zeleň, což vedlo k zvýšení míry eroze a degradace půdy 

a snížení ekologické stability krajiny (Sklenička 2003; Vlasák & Bartošková 2007). 

Důležitou roli při navrhování cest hraje členitost území. Dle ČNS 73 6109 by cesty 

měly co nejlépe kopírovat terén, aby zbytečně nenarůstaly náklady na jejich výstavbu 

a místům, kde by si stavba cesty vyžádala neúměrné náklady, by se mělo při 

plánování vyhnout. Dle uspořádání se polní cesty rozlišují na paralelní, radiální, 

okružní a kombinované. Při navrhování cest v rovinatém terénu lze pracovat 

s paralelním uspořádáním – rovnoběžnou sítí s přibližně pravoúhlým křížením, jehož 

výhodou je pravidelný tvar pozemků, ale dopravní spojení je delší. V členitém terénu 

je naopak nutné respektovat hlavně odtokové poměry území a míru ohrožení vodní 

erozí, a tak se volí radiální uspořádání. Dopravní vzdálenosti jsou nejkratší možné, 

ale u napojení cest vznikají nevhodné tvary pozemků. Kombinovaná soustava spojuje 

kladné prvky paralelního a radiálního uspořádání s ohledem na uspořádání terénu 

i na účelné uspořádání pozemků. Okružní cestní síť je volena v pahorkatinách, cesty 

jsou vedeny po vrstevnicích, a jedná se tak o nejšetrnější sestavu z hlediska 

protierozní ochrany. Volba nejvhodnějšího cestního systému úzce souvisí 

s uspořádáním vodohospodářské soustavy, protože doprovodné prvky cest (např. 

příkopy) významně regulují odtok povrchové vody (Vlasák & Bartošková 2007; Burian 

et al. 2011). 
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Dle významu se polní cesty dělí na (ČNS 73 6109): 

• Hlavní 

• Vedlejší 

• Doplňkové 

Hlavní polní cesty koncentrují dopravu z vedlejších polních cest nebo přímo 

z pozemků. Jsou napojeny na místní komunikace nebo komunikace III. třídy. 

Doporučuje se navrhovat zpevněné jednopruhové cesty s výhybnami v přehledných 

místech, výjimečně dvoupruhové, vždy odvodněné a celoročně sjízdné. 

Vedlejší polní cesty zpřístupňují přilehlé zemědělské pozemky a jsou napojeny na 

hlavní polní cesty i přímo na místní komunikace nebo silnice III. třídy. Navrhují se 

převážně jednopruhové, zpravidla nezpevněné a zatravněné, možná je i pouhá 

kolejová úprava. Výhybny jsou pouze doporučené a v odůvodněných případech 

můžou být cesty zpevněné, případně kombinované. 

Doplňkové polní cesty zajišťují pouze sezonní propojení pozemků jednoho vlastníka 

nebo vytváří hranice mezi pozemky. Doplňkové cesty jsou jednopruhové, 

nezpevněné, případně zatravněné. Výhybny se nenavrhují. 

 

Tabulka 2 Doporučené návrhové kategorie polních cest (ČNS 73 6109) 

Norma ČNS 73 6109 dle velikosti polní cesty doporučuje šířku volné cesty (m) 

a hodnotu návrhové rychlosti (km/h). Doplňkové polní cesty nejsou definovány 

návrhovou kategorií, ale navrhují se dle místních podmínek v šířce 3,0 m, eventuálně 

3,5 m. Kromě parametrů uvedených v technické normě je v návrhu třeba zohlednit 

intenzitu provozu a parametry zemědělské mechanizace, která bude cesty využívat. 

Při dodržení účelu a zatížení navrhované cesty je její životnost obvykle 20 let (SPÚ 

2016a). 

Další zásady, které je doporučeno dle ministerstva zemědělství (2016) při návrhu 

dodržovat: 

• využít nejprve stávající cestní síť s ohledem na její vhodnost, teprve pak 

plánovat cesty nové, 

Vedlejší

Dvoupruhové Jednopruhové Jednopruhové

P 6,0/30
P 4,5/30

P 4,0/30

P 4,0/20

P 3,5/20

Polní cesty*)

Hlavní

*)U zpevněných polních cest se navrhuje krajnice 2 x 0,50 m (v odůvodněných případech 2 x 0,25 m), která se započítává do volné šířky 

polní cesty.
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• zvážit možnost obnovení dříve zaniklých polních cest, jelikož dotvářely 

krajinný ráz a ve velké míře je zachováno jejich pokračování v lesních 

porostech, 

• snažit se odklonit pojezd zemědělské dopravy z komunikací vyšší třídy  

a z intravilánu, 

• navrhovat cestní síť tak, aby se nevytvářely pozemky menší než 3 ha, jelikož 

to významně ovlivňuje způsob obhospodařování půdy a cesta by nemusela 

být dostatečně využívána, 

• vyloučit nebo v maximální míře omezit vytváření věcných břemen zajišťujících 

přístup na pozemky. 

3.2.2 Protierozní opatření 

Eroze je přírodní proces, při kterém působením vody, větru, ledu a dalších činitelů 

dochází k rozrušení půdního povrchu, následnému odnosu částic a jejich usazení na 

jiném místě. Na území České republiky se řeší působení eroze vodní a větrné. 

Přestože se jedná o přírodní proces, existuje obecný vědecký konsensus, že 

současné hodnoty eroze mnohonásobně převyšují ty z doby před intenzifikací 

zemědělství. Použitím vhodných protierozních opatření lze působení vody a větru na 

odnos půdy výrazně omezit, a tak uzpůsobit zemědělskou půdu trvalému užívání 

(Wischmeier & Smith 1978; Roy 2019). Rozlišuje se eroze normální, geologická, 

a eroze zrychlená. Ohrožení půd erozí je celosvětovým problémem, v České 

republice bylo ale v minulosti značně umocněno hospodařením na tisícihektarových 

plochách a rušením významných hydrografických a krajinných prvků. Riziko eroze 

bylo značně podceněno a následky jsou dnes viditelné v milionových škodách nejen 

na zemědělské půdě, ale i v intravilánech, kvůli smyvu půdy ze zemědělských ploch 

a častým škodám způsobených větrnou erozí (Burian et al. 2011; Novotný et al. 

2014). Návrhem protierozních opatření je tak pozitivně ovlivněna také protipovodňová 

ochrana, vodní režim a retenční schopnost půdy a ekologická stabilita (Vlasák & 

Bartošková 2007). 

V případě vodní eroze je negativní dopad eroze dvojí – na místě odnosu a na místě 

sedimentace. Na místě odnosu je půda ochuzována o ornici, nejúrodnější vrstvu 

půdy, a zmenšuje se tak mocnost půdního profilu, poškozuje pěstované plodiny 

a snižuje obsah živin a humusu. Naopak transportované částice zanášejí příkopy, 

vodní toky a nádrže; kvůli hromadění živin pak dochází k eutrofizaci, což ovlivňuje 

míru zakalení vody a zhoršuje prostředí pro vodní organismy. V případě větrné eroze 

se pak jedná hlavně o narušení klíčících semen rostlin, znečištění ovzduší 
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prachovými částicemi nebo akumulaci půdy na nepůvodní lokalitě (Vlasák & 

Bartošková 2007; Burian et al. 2011). 

Dle zákona 254/2001 Sb., o vodách a změně některých zákonů jsou vlastníci 

pozemků povinni zajistit péči o ně tak, aby nedocházelo ke zhoršování vodních 

poměrů, tzn. aby nedocházelo ke zhoršování odtokových poměrů, snižování retenční 

schopnosti půdy nebo odnosu půdy vodní erozí, což má přímý vliv také na omezování 

degradace půdy. 

V České republice existují od roku 2010 ministerstvem zemědělství kontrolované 

standardy Dobrého zemědělského a environmentálního stavu půdy (GAEC). 

Poskytování veškerých státních a některých dotačních prostředků z Programu 

rozvoje venkova zemědělcům je podmíněno dodržováním standardů GAEC I. 

a GAEC II., neboli hospodařením ve shodě s ochranou životního prostředí. Jejich 

plnění je kontrolováno Státním zemědělským intervenčním fondem buď nepřímo, 

pomocí dálkového průzkumu země, nebo přímo v terénu. GAEC I. ukládá opatření při 

hospodaření na svažitých pozemcích, GAEC II. určuje zásady pěstování vybraných 

plodin na silně a mírně erozně ohrožených územích (Batysta et al. 2014; Novotný et 

al. 2014). Současné nastavení dotačních programů je však stále velmi mírné 

a dotační výměr je převážně odvislý od velikosti plochy obhospodařované půdy, a ne 

od zajišťování mimoprodukčních funkcí krajiny, včetně zmírňování projevů a dopadů 

eroze (Novotný et al. 2014). Připravovaná Společná zemědělská politika Evropské 

unie po roce 2020 počítá s tím, že distribuování prostředků poskytovaných v rámci 

Evropského zemědělského fondu pro rozvoj venkova bude podmíněno plněním 

závazků vůči životnímu prostředí a klimatu (Massot 2019). 

Vodní eroze 

Nechráněný půdní povrch je rozrušován dopadajícími dešťovými kapkami, které tak 

svou kinetickou energií uvolňují půdní částice. Je-li úhrn a intenzita srážek vyšší, než 

je retenční schopnost půdy, jsou uvolněné částice unášeny povrchovým odtokem. 

Snížením sklonu terénu klesá transportní schopnost vody a částice se tak usazují 

(Burian et al. 2011). Největší vliv na vznik vodní eroze má svažitost pozemku, délka 

pozemku po spádnici, vegetační pokryv, vlastnosti půdy a její náchylnost k erozi, 

aplikovaná protierozní opatření a počasí, kdy jsou přívalové deště střídány obdobím 

sucha. Většina erozně nebezpečných dešťů se objevuje v období červen–srpen; 

v zimě a na jaře dochází k nebezpečnému tání sněhu na zledovatělém podloží. 

V České republice je vodní erozí ohroženo více než 50 % výměry orné půdy. Na slabě 

erodovaných půdách jsou výnosy sníženy o 15–20 %, na středně erodovaných o 40–
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50 % a na silně erodovaných půdách až o 75 %. Degradace půdy erozí se výrazně 

promítá do průměrné ceny pozemku, jelikož je zahrnuta ve výpočtu bonitovaných 

půdně ekologických jednotek (BPEJ) (Batysta et al. 2014; Novotný et al. 2014). 

Vodní erozi lze dělit do dvou forem – erozi plošnou a výmolnou. Přechod mezi těmito 

dvěma typy je pozvolný, je závislý na přechodu plošného odtoku vody v soustředěný. 

Plošná eroze se vyznačuje rovnoměrným odnosem částic po celé ploše a dochází tak 

k snižování mocnosti půdy. Tento typ eroze nezanechává viditelné stopy, ale lze ji 

detekovat z jemného materiálu, který se akumuluje v dolní části svahu. Voda odnáší 

jemné, převážně organické, částice, a tak se mění fyzikální i chemické složení půdy, 

které může vést až ke snížení retenční schopnosti půdy a snížení humusové složky 

půdy. Postupným působením plošné eroze se v půdě vytvářejí zářezy a dochází tak 

k soustředěnému odtoku a erozi výmolné. Výmolná eroze se dále podle intenzity 

zářezů v půdě dělí na erozi rýžkovou a brázdovou, rýhovou, výmolnou a stržovou 

(Burian et al. 2011; Novotný et al. 2014).  

Hodnocení ohrožení půdy vodní erozí 

K určování ohroženosti zemědělských půd se užívá tzv. Univerzální rovnice pro 

výpočet dlouhodobé ztráty půdy erozí – USLE. Rovnice určí hodnotu dlouhodobé 

přípustné ztráty půdy, která je definována jako maximální velikost eroze půdy, při 

které je možné ekonomicky i environmentálně udržitelně uchovávat dostatečnou 

úrodnost půdy (Janeček et al. 2012). 

Rovnice USLE (Wischmeier & Smith 1978): 

𝑮 = 𝑹 ∙ 𝑲 ∙ 𝑳 ∙ 𝑺 ∙ 𝑪 ∙ 𝑷 

G – průměrná dlouhodobá ztráta půdy (t.ha-1.rok-1) 

R – faktor erozní účinnosti deště, vyjádřený v závislosti na kinetické energii, úhrnu a intenzitě 
erozně nebezpečných dešťů (MJ.ha-1.cm.h-1), resp. (N.ha-1) 

K – faktor erodovatelnosti půdy, vyjádřený v závislosti na textuře a struktuře ornice, obsahu 
organické hmoty a propustnosti půdního profilu (t.h.MJ-1.cm-1), resp. (t.N-1) 

L – faktor délky svahu, vyjadřující vliv nepřerušené délky svahu na velikost ztráty půdy erozí 

S – faktor sklonu svahu, vyjadřující vliv sklonu svahu na velikost ztráty půdy erozí 

C – faktor ochranného vlivu vegetace, vyjádřený v závislosti na vývoji vegetace a použité 
agrotechnice 

P – faktor účinnosti protierozních opatření 

 

Hodnota G je následně porovnána s přípustnou průměrnou roční ztrátou (GP). Pokud 

hodnota dlouhodobé průměrné ztráty půdy nepřekročí hodnotu dlouhodobé přípustné 

ztráty půdy, tedy 𝑮 ≤ 𝑮𝑷, nedochází na dané lokalitě ke zrychlené erozi. Pokud ale 

hodnota dlouhodobé průměrné ztráty půdy překročí hodnotu dlouhodobé přípustné 
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ztráty půdy, tedy 𝑮 > 𝑮𝑷, dochází k nadměrnému odnosu půdy, čímž je ohrožena 

její úrodnost a další funkce (Novotný et al. 2014). Pro ochranu půd v České republice 

se mělké půdy s hloubkou do 30 cm nedoporučují používat pro polní výrobu a je lépe 

je zatravnit či zalesnit. Pro středně hluboké půdy (30-60 cm) ale i půdy hluboké (nad 

60 cm) se doporučuje použít jednotnou hodnotu dlouhodobé přípustné ztráty půdy ve 

výši 4 t.ha-1.rok-1. Pro posuzování ochrany vodních zdrojů je třeba postupovat 

individuálně, nicméně hranice dlouhodobé přípustné ztráty půdy, při které ještě 

nevzniká výraznější eutrofizace vod je v rozmezí od 0,5 do 2 t.ha-1.rok-1  (Janeček et 

al. 2012). 

Protierozní opatření 

Protierozní opatření slouží k podpoře retenční schopnosti půdy, omezení, zpomalení 

a bezpečném odvedení povrchového odtoku do vodoteče či jiného určeného místa. 

Při jejich navrhování je třeba postupovat od těch finančně i realizačně 

nejjednodušších. Při návrhu společných zařízení je také třeba prokázat účinnost 

navrhovaných opatření, a to nejlépe vypočtením rovnice USLE před a po jejich 

návrhu. Navržený systém je třeba vhodně doplnit o doprovodné prvky jako propustky 

a sedimentační jímky. Nedoporučuje se svodné prvky zaúsťovat do kanalizace (SPÚ 

2016a). 

Navrhovaná opatření (Burian et al. 2011; Janeček et al. 2012; Batysta et al. 2014; 

Novotný et al. 2014): 

• Opatření organizačního charakteru 

o Optimální tvar a velikost pozemku, situování pozemků delší stranou po 

vrstevnici 

o Vhodný výběr pěstovaných plodin a jejich umístění 

o Delimitace pozemků – zatravnění, zalesnění 

o Pásové střídání plodin 

• Agrotechnická opatření 

o Setba a obdělávání po vrstevnici 

o Ochranné obdělávání – zanechání min. 30 % rostlinných zbytků 

nezaoraných; setba do ochranné plodiny případně mulče 

o Hrázkování, důlkování plodin 

• Technická opatření 

o Příkopy 

o Průlehy 

o Zatravněné dráhy soustředěného odtoku 
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o Polní cesty s protierozní funkcí 

o Hrázky 

o Meze 

o Nádrže 

o Terasy 

o Terénní urovnávky 

Větrná eroze 

Větrná eroze je přirozený proces, při kterém je půda rozrušována mechanickou silou 

větru a půdní částice jsou přenášeny na různou vzdálenost. Po snížení rychlosti větru 

se částice usazují zpět na zemský povrch. Počáteční vlečná rychlost větru pro odnos 

částic je stanovena od 3,3 m/s pro písčité po 22 m/s pro půdy hlinité. Větrnou erozí 

jsou tak především ohroženy lehké půdy (Novotný et al. 2014). Větrná eroze se může 

vyskytovat celoročně, ale nejškodlivější bývá v jarním a podzimním období, kdy půda 

není chráněna vegetací nebo sněhem. Z tohoto hlediska jsou nejohroženější půdy 

bez vegetace. K nejzásadnějším negativním vlivům větrné eroze patří snížení 

mocnosti půdního profilu a odnos jemných částic, což způsobuje větší skeletovitost 

půdy. Může také dojít ke změně odtokového režimu vod a snížení sorpční kapacity. 

Tyto jevy působí negativně především na úrodnost půdy a biologickou aktivitu v ní 

(Batysta et al. 2014; Novotný et al. 2014). 

Hodnocení ohrožení půdy větrnou erozí 

Pro stanovení skutečné náchylnosti půdy k erozi je třeba znát okamžitou rychlost 

větru a vlhkost půdy. Pro potřeby návrhu protierozních opatření v pozemkových 

úpravách se proto využívá stanovení potenciální erodovatelnosti, odvozené od 

charakteristik lokality. Dle Janečka et al. (2012) lze pro stanovení potenciální 

erodovatelnosti využít následujícího vztahu: 

𝑬 = 𝟖𝟕𝟓, 𝟓𝟐 × 𝟏𝟎−𝟎,𝟎𝟕𝟖𝟕𝑴 

E – erodovatelnost půdy větrem (t.ha-1.rok-1) 

M – obsah jílnatých částic v půdě (%) 

Vztah byl odvozen na základě pokusu v aerodynamickém tunelu. Lze jej ale použít 

pouze pro lehké půdy s nízkým obsahem jílovitých částic, jelikož rovnice nepočítá 

s faktem, že by k větrné erozi mohlo docházet i na jílovitých půdách. Za přirozený 

odnos půdy se považuje odnos vrstvy půdy o mocnosti 0,05 mm. Pokud je tato 

hodnota překročena, jedná se o erozi zrychlenou (antropogenní) (Janeček et al. 

2012). 
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Protierozní opatření 

Ministerstvo zemědělství (2016) zmiňuje následující protierozní opatření: 

Opatření organizačního charakteru 

o Protierozní rozmisťování plodin 

o Pásové střídání plodin 

o Vhodné osevní postupy 

o Tvar a velikost pozemků 

• Agrotechnická opatření 

o Používání protierozních postupů (setí, sklizeň, posklizňové zbytky) 

o Zvýšení odolnosti půdy (zlepšení fyzikálních vlastností půdy) 

• Technická opatření 

o Větrolamy 

▪ Proudovavý 

▪ Neproudovavý 

▪ Poloprodouvavý 

o Přenosné zábrany 

Prodouvavost větrolamů se odvíjí od jejich skladby. Prodouvavý větrolam je složen 

pouze ze stromů bez keřového patra. Protierozní efekt je tak nízký. Neprodouvavý 

typ je složen z linie stromů se zapojeným keřovým pásem. Vytváří se tak neprostupná 

stěna, při jejímž obtékání vítr značně ztratí na síle, ale klesá k zemskému povrchu 

v kratší vzdálenosti. Nejvhodnějším typem je tak poloprodouvavý větrolam, který 

střídavě kombinuje umístění stromů a keřů, a tak vítr těleso nejen obtéká, ale i jím 

prostupuje. Dochází k rychlejšímu obtékání větrem než u větrolamu neprodouvavého, 

ale vítr klesá k zemi ve větší vzdálenosti za překážkou (Janeček et al. 2012; Novotný 

et al. 2014). 

Jako větrné bariéry se nejčastěji navrhují ochranné lesní pásy (OLP) a ostatní liniové 

vegetační prvky (LVP). Tabulka 3 shrnuje limitní parametry ochrany těchto dvou typů 

větrolamů (SPÚ 2016b). 

 

Tabulka 3 Parametry ochranných zón větrných bariér (SPÚ 2016b) 
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3.2.3 Vodohospodářská opatření 

V rámci procesu komplexních pozemkových úprav se navrhují opatření pro podporu 

zvýšení retenční schopnosti krajiny a vodohospodářská opatření zajišťující bezpečný 

povrchový odtok a dobrou kvalitu jakosti vody. Další skupinou úprav jsou pak 

revitalizace toků nebo rekonstrukce melioračních staveb (Vlasák & Bartošková 2007). 

Velmi kontroverzní kapitolou ve vývoji vodohospodářských opatření je masivní využití 

melioračních opatření na zemědělských půdách v 60. až 80. letech 20. století. Došlo 

jím k zásadnímu ovlivnění vodního a vzdušného režimu půdy (Kvítek 2017). Dle 

Kvítka (2017) je ideální takový stav, kdy k zachycení vody dojde ještě na 

zemědělských pozemcích, kde dojde k sedimentaci částic a infiltraci vody. Následně 

by zbytková povrchová voda měla být odváděna travními porosty a mokřady, aby 

došlo k využití rozpuštěných látek. Do travních porostů by proto měly být vyústěny 

i drenážní systémy. Takto je voda odvedena do akumulačních nádrží a lze ji dále 

využít. 

Členění vodohospodářských opatření (Kvítek 2017): 

Opatření vhodná pro horní a střední části povodí: 

• Zatravnění infiltračních oblastí na rozvodnicích – pomocí trvalého zatravnění 

vrcholů mírně svažitých kopců se zkrátí délka svahu a podpoří vsak povrchové 

vody 

• Zasakovací travní pás v rámci bloku orné půdy – vhodné pro málo 

morfologicky členitý terén bez drah soustředěného odtoku; rozdělení velkých 

půdních bloků orné půdy přispívá k nižší míře vodní eroze, pás o šířce 50–

60 m, minimálně však 20 m se umisťuje po vrstevnici; při sklonu svahu vyšším 

než 7° je třeba pruh doplnit záchytným příkopem nebo průlehem 

• Zatravnění drah soustředěného odtoku povrchových vod – v případě, že je 

svah přerušený liniovou stavbou; bezpečný odtok je limitován kapacitou 

propustků 

• Přehrážky v úžlabí a stržích – eliminace vysokých a rychlých průtoků; 

nevýhodou je, že plocha tohoto prvku není využívána a že při zanesení 

sedimenty se snižuje retenční schopnost 

Opatření pro zasakování povrchových vod:  

• Vyústění drenážních vod do záchytných retenčních opatření – drenážní voda 

by kvůli kontaminaci neměla být odváděna přímo do podzemních vod, protože 
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je často obohacená o látky používané v zemědělství, vhodný je její převod 

přes trvalé travní porosty do vodních nádrží nebo toků 

• Mez se záchytným průlehem a zasakovacím pásem (Obrázek 1) – vhodné pro 

dlouhé svahy zatížené plošnou nebo rýhovou erozí, pomocí průlehu lze 

zadržet a přerušit povrchový odtok 

• Zasakovací jámy drenážních systémů (Obrázek 2) – vhodné pro roviny, kdy 

je odvodňovací kanál vyveden na povrch terénu a vyústěn do jámy; opatření 

může být navrhováno i jako soustava jam spojených příkopy – jámy působí 

jako tůně s funkcí bio čistírny. Řešení má pozitivní vliv na biodiverzitu krajiny 

i krajinný ráz a zároveň je levnější než klasická revitalizace vodních toků 

 

Obrázek 1 Příčný řez záchytným průlehem (Kvítek 2017) 

 

Obrázek 2 Soustava zasakovacích jam (Kvítek 2017) 

• Záchytný příkop se zasakovacím pásem – příkopy jsou vhodným opatřením 

pro bezpečné odvedení vody z pozemku, často jsou doprovodným prvkem 

liniových prvků 
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• Zasakovací průleh se zasakovacím pásem – díky větším rozměrům je průleh 

účinnější než příkop; svodný průleh je vhodný pro zachycení prudkých 

přívalových dešťů a jarního tání sněhu, záchytný pro nepřípustné délky svahů 

• Malé vodní nádrže – možnost zadržení odtékající podpovrchové vody v horní 

části povodí, možná funkce přečerpávací nádrže s nádržemi v nižších 

polohách 

• Zasakovací galerie na svodných a záchytných příkopech (Obrázek 3) – cílem 

opatření je zadržení odtoku vody z příkopů, kdy se do vykopané jámy instaluje 

vsakovací galerie překrytá fólií chránící galerii před zanášením a instaluje se 

vpustní objekt pro příkop  

  

Obrázek 3 Zasakovací galerie pod ornou půdou (Kvítek 2017) 

Opatření vhodná pro dolní část povodí: 

• Zatravněná údolnice – vhodné pro limitaci erozních jevů při srážkách, může 

být doprovozena příkopem 

• Umělý mokřad v údolnici – lze aplikovat na plochy trvale zamokřené 

nevyužívané zemědělské půdy, lze do nich také vyvést drenážní vody 

• Víceúčelové hrázky – převážně záchytná, infiltrační a protierozní funkce, mají 

menší rozměry než mez, mohou mít vypouštěcí objekt (skruž s česlemi) 

• Sedimentační zatravněné pásy podél vodních útvarů 

• Poldry – hlavní funkce je protipovodňová, jsou hloubeny v drahách 

soustředného odtoku vody, průtočné nebo boční, kam případně voda 

přepadává z hlavního toku; vysoké nároky na bezpečný provoz 

• Malé vodní nádrže s retenčním prostorem 
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3.2.4 Opatření k ochraně a tvorbě životního prostředí 

Z hlediska geologického i fylogenetického vývoje jsou změny způsobené jako 

následek lidské činnosti změnami náhlými a nepředvídatelnými a působí v krajině 

jako disturbance (Lipský 1998). Krajinné úpravy a krajinná fragmentace jsou hlavními 

příčinami globálního vymírání druhů (Fischer & Lindenmayer 2007), jelikož přispívají 

ke snižování přirozených habitatů druhů (Sala & kol. 2000). Kvůli fragmentaci dochází 

ke zvyšování vzdáleností mezi jednotlivými stanovišti, čímž dochází ke ztrátě či 

zmenšení biotopů a jejich původní funkce. Takto nově vytvořené habitaty mívají 

charakter ostrovního ekosystému, jelikož se změní jejich mikroklima i biogeografické 

podmínky, přičemž míra těchto změn závisí na velikosti, tvaru a umístění izolované 

plošky (Saunders & kol. 1991). Tyto izolované habitaty bývají více či méně propojeny 

koridory. Ochrana, údržba a případná introdukce koridorů může pomoci zmírnit či 

zvrátit následky fragmentace (Williams & Snyder 2005). 

Na základě výše zmíněných úvah o fungování krajinných struktur a vlivu člověka je 

v České republice založen koncepční nástroj ochrany přírody Územní systém 

ekologické stability krajiny (ÚSES). Je definován § 3 zákona 114/1992 Sb., o ochraně 

přírody a krajiny, v platném znění, jako vzájemně propojený soubor přirozených 

i pozměněných, avšak přírodě blízkých ekosystémů, které udržují přírodní rovnováhu. 

Cílem ÚSES je vytvoření sítě relativně ekologicky stabilních území, která mají 

pozitivní vliv na méně stabilní okolní krajinu a zároveň snaha o znovuobnovení 

přirozeného genofondu krajiny při zachování biodiverzity původních druhů 

a společenstev (Sklenička 2003; Glos & Petrová 2010). 

ÚSES je považován za tzv. ekologické minimum nutné pro udržení relativně stabilní 

krajiny. Je členěn do tří úrovní – lokální, regionální a nadregionální, kdy přímý vliv na 

krajinu má ten lokální. Základními skladebnými prvky jsou biocentra, biokoridory 

a interakční prvky. Biocentra lze rozdělit na reprezentativní, kde jsou zastoupené 

charakteristické ekosystémy, a unikátní, která jsou pro danou biogeografickou 

jednotku netypické. Biokoridory plní migrační funkci a propojují biocentra do vyššího 

regionálního celku. Interakční prvky také stabilizují krajinu, pouze u nich nutně neplatí 

zapojení do sítě biocenter a biokoridorů. Charakteristických znakem pro interakční 

prvky je jejich ekotonální charakter (Sklenička 2003). 

Dle Skleničky (2003) zásady vymezování ÚSES vycházejí z pěti základních principů: 

• Princip reprezentativnosti – v ÚSES musí být zahrnuty ukázky všech typických 

společenstev daného regionu 
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• Princip limitních prostorových parametrů – limitními parametry jsou minimální 

velikost biocentra, minimální šířka biokoridoru a maximální délka biokoridoru 

(Obrázek 4) 

• Princip prostorových vztahů – biokoridory by měly propojovat vzájemně si 

blízké ekosystémy 

• Princip aktuálního stavu krajiny – přednostně se zařazují do ekosystému ve 

vyšším stupni sukcese, v antropicky ovlivněném prostředí je určující míra 

přirozenosti ekosystému, ne sukcesní vyspělost 

• Princip společenských limitů a závěrů – ÚSES je primárně vymezován 

s polyfunkčním využitím (protierozní, hydrologická, estetická opatření), aby se 

omezil střet ekologických a ostatních společenských požadavků 

 

Obrázek 4 Orientační hodnoty prostorových parametrů skladebných prvků ÚSES (Sklenička 2003)  
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3.3 Využití GIS 

Dle Formana a Godrona (1993) je vývoj krajiny formován geomorfologickými procesy, 

osídlováním krajiny organismy a disturbancí klimatickými vlivy. Za nejvýraznějšího 

činitele ovlivňujícího strukturu a utváření krajiny je považován člověk a jeho činnost 

(Vitousek & kol. 1997). Pro vyhodnocování změny krajiny se používají různé 

metodologie, vesměs však všechny postupují tak, že krajinu popisují, klasifikují 

a následně analyzují (Sklenička 2003). Výsledky těchto analýz prostorových změn 

v krajině bývají nejčastějšími ukazateli heterogenity (Pazúr & kol. 2012). 

Jako vstupní zdroje dat pro krajinnou analýzu nejčastěji slouží letecké či družicové 

snímky, které jsou zpracovány pomocí dálkového průzkumu Země (DPZ) či 

geografických informačních systémů (GIS) (Guth & Kučera 1997). Pomocí rozličných 

indexů a krajinných metrik pak lze vstupní data zpracovat a kvantifikovat 

charakteristiky, na základě kterých je možno následně vyjádřit specifika krajiny 

(Buyantuyev & Wu 2007). Rychlý rozvoj GIS technologie v posledních desítkách let 

přinesl mnoho analytických nástrojů vhodných pro analýzu krajiny (McGarigal & 

Marks 1994). 

Jedním z těchto nástrojů v prostředí GIS je digitální model terénu (DMT). DMT 

pomocí, ideálně velkého počtu, interpolovaných vybraných bodů o známých 

souřadnicích X, Y a Z v libovolném souřadnicovém systému reprezentuje reliéf terénu 

a umožňuje tak krajinu dále analyzovat. Například pomocí geomorfometrických 

analýz zabývajících se analýzou geometrie tvarů zemského povrchu (Rapant 2006). 

V GIS jsou nejběžněji využívanými obecnými geomorfometrickými analýzami 

sklonitost, expozice nebo zakřivení. Ze specifických analýz pak nacházejí využití 

hydrologické analýzy jako směr a velikost odtoku a akumulovaný odtok. Tyto metody 

jsou využívány i při výpočtu eroze v prostředí GIS, jelikož algoritmy těchto analýz 

vycházejí z předpokladu, že hlavním faktorem modelujícím reliéf jsou hydrologické 

procesy (Klimánek 2006). 

DMT je klíčovou vstupní vrstvou pro výpočet rovnice USLE k určení smyvu půdy 

v prostředí GIS. Za podmínky, že jsou použita vhodná vstupní data, vede využití 

geoinformačních systémů k výraznému zpřesnění výpočtů (Krása et al. 2006). 

Analýza probíhá na bázi rastru a kalkulací s rastry. Existují tři základní typy modelů 

pro výpočet USLE. Modely se liší zejména přístupem ke stanovení faktoru LS 

(Janeček et al. 2012): 

1.  Vyčíslují pouze plošný smyv (rýhovou erozi) v souladu s původním 

odvozením metody USLE. 
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2. Zohledňují velikost odtokové plochy v každém bodě, a tak určují také 

mezirýhovou erozi. 

3. Bilanční modely, které kromě rýhové a mezirýhové eroze vyčíslují také 

depozici. 

Představiteli typu 1. je například model RUSLE nebo v ČR nejčastěji užívaný 

USLE2D. Příklady typu 3. jsou modely RUSLE2, USPED nebo WATEM/SEDEM 

(Janeček et al. 2012). 

Model USLE2D byl využitý i pro současnou verzi veřejného registru zemědělské půdy 

LPIS. Klíčovou výhodou této metody je možnost variabilního směřování odtoku při 

stanovování odtokových ploch, což umožňuje pracovat s kvalitativně různými DMT 

(Janeček et al. 2012). 
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4. Charakteristika zájmového území 

Obec Semice, resp. katastrální území Semice nad Labem (Obrázek 5), se nachází 

ve Středočeském kraji severovýchodně od Prahy v okrese Nymburk, asi 5 km 

jihovýchodně od města Lysá nad Labem. Semice jsou společně se sousedními 

obcemi členem dobrovolného sdružení obcí Mikroregion Polabí (Obec Semice 2018). 

Výměra katastrálního území je 9,43 km². Katastrální území je na severu ohraničeno 

pravým břehem řeky Labe, která je tak součástí k.ú. Semice nad Labem. Sousedními 

k. ú. jsou Ostrá, Hradišťko u Sadské, Velenka, Starý Vestec, Přerov nad Labem a 

Litol. 

První záznamy o osídlení obce pocházejí již z roku 1352. Na rozvoj obce, ve které 

vždy bylo hlavní hospodářskou činností zemědělství, mělo rozhodující vliv 

ekonomické smýšlení soukromě hospodařících rolníků. Záznamy o prvních 

zavlažovacích systémech existují už z roku 1904. Díky melioračním systémům došlo 

ke zvýšení výnosů půdy a ve větší míře se zde začaly pěstovat plodiny, jako jsou rané 

brambory a různé druhy zeleniny (Obec Semice 2018).  

 

Obrázek 5 Katastrální území Semice nad Labem 
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4.1 Charakteristika přírodních podmínek 

4.1.1 Klimatické podmínky 

Dle Quitta (1971) leží Semice v teplé a relativně suché oblasti T2. Region středního 

Polabí je obecně velmi teplý, xerotermní, má vůbec nejvyšší roční průměrnou teplotu 

(9,0 °C) v Čechách. Celkový spad srážek za rok je okolo 560 mm. Dle zařazení do 

klimatického regionu používaného pro potřeby BPEJ je území klasifikováno jako 

region s kódem 2. Tyto regiony sdružují území s přibližně shodnými klimatickými 

podmínkami pro růst a vývoj zemědělských plodin. Jedná se, stejně jako v hodnocení 

dle Quitta, o teplý, mírně suchý klimatický region (VÚMOP 2019). 

4.1.2 Hydrologické podmínky 

Celé území Semic se nachází v povodí Labe, které samotné protéká severním 

územím katastru, konkrétně v povodí Labe od Výrovky po Jizeru 1-04-07. Majoritní 

část území je ale odvodňována Semickým potokem 1-04-07-0390-0-00, který 

pramení v sousedním k. ú. Starý Vestec a ústí do Kounického potoka 1-04-07-0400-

0-00 v k. ú. Přerov nad Labem. Plocha dílčího povodí Semického potoka je 11,63 km2. 

Dalšími menšími toky jsou Psárecký potok a toky V Záluží a Z Horky. Vodní režim 

území je silně antropogenně ovlivněn, jelikož celé území je protkáno melioračními 

kanály, které sušší oblasti zavlažují a vlhčí odvodňují (Obec Semice 2018). V severní 

části katastrálního území se také nachází několik slepých a mrtvých ramen Labe. 

4.1.3 Geomorfologické zařazení 

Katastrální území Semice je v rámci geomorfologického členění České republiky 

součástí Hercynského sytému, subsystému Hercynského pohoří, provincie České 

vysočiny, subprovincie České tabule, oblasti Středočeské tabule, celku Středolabská 

tabule, podcelku Nymburská kotlina, okrsku Sadská rovina. Sadská rovina se již dále 

dělí pouze na jednotlivé vrcholy, které jsou zároveň geomorfologickými částmi 

a jednou z nich je Semická hůra, ležící na území obce Semice (Demek & Mackovčin 

2006). Semice jsou součástí Polabského bioregionu. Jedná se o erozně akumulační 

rovinu vytvořenou Labem, která je tvořená říčními terasami a nivami. Reliéf má typicky 

charakter roviny s výškovou členitostí do pouhých 30 m, pouze u Semické hůry 

přechází v plochou pahorkatinu s členitostí do 75 m (Culek 1995). 

4.1.4 Geologické poměry 

Semická hůra je s výškou 231 m nejvyšším bodem zájmového území. Nachází se 

jihozápadně od obce Semice a jedná se o výraznou dominantu krajiny. Vrch vznikl 

říční erozí Labe a kryoplanačními procesy. Je oproti zbytku území složen netypicky 

ze středoturonských slínovců a písčitých slínovců tvořících vrcholovou plošinu 
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s příkrými okrajovými svahy místy porušenými sesuvy. Zakrývá jej borový porost 

s příměsí listnatých dřevin. Nízké terasy a nivní oblasti zbytku území jsou z velké míry 

tvořeny sedimenty kvartéru, jedná se o písčité až jílovité hlíny až štěrkopísky až písky 

(Demek & Mackovčin 2006). 

4.1.5 Pedologické poměry 

Ve vzdálenosti do 1 km od Labe se nacházejí hlavně nivní sedimenty – modální 

fluvizemě. Jedná se o půdy vzniklé ze středně těžkých substrátů charakterizované 

pouze fluvickými znaky (znatelné zbytky vrstevnatého uložení, nepravidelné rozložení 

organických látek s obsahem vyšším než 0,3 % do hloubky 0,6 m). Na zbytku území 

pak lze nalézt pelické a modální černozemě, arenické černice a arenické regozemě. 

Černozemě jsou hlubokohumózní (0,4-0,6 m) půdy s černickým horizontem vyvinuté 

z karbonátových sedimentů. Jsou to sorpčně nasycené půdy s vysokým obsahem 

humusu (2,0 - 4,5 %). Vytvořily se v sušších a teplejších oblastech ve vegetačním 

stupni 1–2 ze spraší, písčitých spraší a slínů. Arenické černice jsou hlubokohumózní 

(> 0,3 m), semihydromorfní půdy vyvinuté z nezpevněných karbonátových substrátů 

s černickým horizontem. Mají indikovaný vyšší obsah humusu, než mají okolní 

černozemě. Vyskytují se jihovýchodně od obce v depresních polohách černozemních 

oblastí a na těžších substrátech. Arenické regozemě jsou půdy vyvinuté ze sypkých 

sedimentů, a to hlavně písků (v rovinatých částech reliéfu), kde minerálně chudý 

substrát či krátká doba pedogenese zabraňuje výraznějšímu vývoji profilu. Vyskytují 

se však také v polohách, kde je vývoj půd narušován vodní erozí (Němeček et al. 

2001; CENIA 2018). 

4.1.6 Biota 

Semice leží v oblasti Českého termofytika v Poděbradském Polabí, kde je výškově 

převážně zastoupena flóra planárního vegetačního stupně. Většina území se 

přirozeně vyskytuje v 2., bukovo-dubovém vegetačním stupni, vlivem substrátu je 

však území převážně dubové (Culek 1995). Na vrcholu Semické hůry byly bohužel 

nevhodně založeny maloplošné kultury borovice černé (Pinus nigra). Lokalita je 

významná i výskytem celé řady vzácných druhů bezobratlých (AOPK 2006). 

V okolí Labe je zastoupena Hercynská dubohabřina a makrofytní vegetace přirozeně 

eutrofních a mezotrofních stojatých vod (Culek 1995). Bylinný podrost je vyvinut 

v typické podobě, v jarním aspektu se výrazně uplatňuje česnek medvědí (Allium 

ursinum). Mezi typické zástupce stromového patra patří dub letní, jasan, olše, méně 

habr, jilm a javor. Degradačními prvky jsou přítomnost dubu červeného, hybridních 
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topolů a v bylinném patře invazivní druh netýkavka malokvětá (Impatiens parviflora) 

(Gerža 2015). 

V jihovýchodní části území je patrný antropogenní vliv intenzivního obhospodařování 

a vyskytují se zde tak i druhy typické pro písčiny (Chytrý et al. 2010).  

4.2 Popis území a jeho využití 

V katastrálním území Semice byly k 1. 12. 2016 zahájeny komplexní pozemkové 

úpravy, ale v současné době jsou stále v neukončeném stavu a ani nebyl zveřejněn 

návrh plánu společných zařízení. 

4.2.1 Členitost reliéfu a krajinný ráz 

Vybrané katastrální území se nachází v Polabské nížině v úvalu řeky Labe. Obec 

Semice se nachází v nadmořské výšce pouhých 179 m n. m. a až na solitérní 

Semickou hůru se ani zbytek katastrálního území od této hodnoty příliš neodchyluje, 

reliéf není členitý. Jedná se čistě o polní, intenzivně zemědělsky využívanou krajinu 

tak typickou pro tento kraj, že by se ve zdejší lokalitě daly rozlehlé lány pokládat za 

významný krajinný prvek (VKP). Registrovaným VKP je Semická hůra rozhodnutím 

ŽP VL 4/04-Sv ze dne 8. 1. 2004 (MÚ Lysá nad Labem 2016). 

Do katastrálního území Semic na východě částečně zasahuje přírodní park 

Kersko – Bory, jenž byl zřízen z důvodu ochrany krajinného rázu krajiny 

s významnými soustředěnými přírodními a estetickými hodnotami, s výrazným 

harmonickým měřítkem, zejména rozlehlými lesními komplexy Kerského lesa 

přecházejícími do otevřených prostor zemědělské polabské krajiny (Středočeský kraj 

2010). 

4.2.2 Struktura půdního fondu 

Na většině území, vyjma pozemků v těsné blízkosti Semické hůry, se nacházejí 

nadstandardně úrodné typy půd. Místní bonitované půdně ekologické jednotky jsou 

typicky 2.xx.00. Jedná se o nadprůměrně produkční půdy s všesměrnou expozicí  

a v úplné rovině v teplém regionu. Jsou to vysoce chráněné fluvizemě, černice, 

černozemě a regozemě s II. či I. stupněm ochrany půdy dle Vyhlášky o stanovení tříd 

ochrany č. 48/2011 Sb, které lze odejmout ze ZPF pouze výjimečně a nejsou vhodné 

k zatravnění či zalesnění a ke stavbě vodních nádrží. Jedná se o půdy s přirozeně 

vysokou a střední retenční schopností bez náchylností k zamokření či vysychání 

(VÚMOP 2019).  

Druhé a třetí místo kódu BPEJ označuje hlavní půdní jednotku (HPJ), což je účelové 

seskupení půdních forem příbuzných vlastností, jež jsou určeny geneticky půdním 
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typem, subtypem, půdotvorným substrátem, zrnitostí, hloubkou půdy, stupněm 

hydromorfismu, případně výraznou sklonitostí nebo morfologií terénu a zúrodňovacím 

opatřením (Dufková et al. 2005).  

Hlavní půdní jednotky zastoupené na řešeném území, kategorizované dle vyhlášky 

č. 227/2018 Sb a VÚMOP 2019: 

04 Černozemě arenické na sprašovém překryvu vápnitých písků uložených na 

píscích a štěrkopíscích, zrnitostně převážně lehké, bezskeletovité až slabě 

skeletovité, silně propustné půdy s výsušným režimem. 

06 Černozemě pelické, černozemě pelické karbonátové a černozemě černické 

karbonátové na velmi těžkých substrátech (jílovité břidlici a slínech), těžké až velmi 

těžké s vylehčeným orničním horizontem, s tendencí povrchového převlhčení v profilu 

kvůli nízké rychlosti infiltrace. 

20 Pelozemě modální, vyluhované a melanické, regozemě pelické, kambizemě 

pelické i pararendziny pelické včetně slabě oglejených variet na velmi těžkých 

substrátech (slíny a měkká břidlice), půdy s velmi nízkou rychlostí infiltrace i při 

úplném nasycení, půdy s trvale vysokou hladinou podzemní vody, půdy s vrstvou jílu 

na povrchu nebo těsně pod ním a mělké půdy nad téměř nepropustným podložím. 

21 Půdy arenického subtypu – regozemě, pararendziny, kambizemě a fluvizemě na 

lehkých, nevododržných, silně výsušných substrátech jako jsou štěrky a písky, bez 

skeletu. 

41 Silně svažité půdy se sklonitostí vyšší než 12 stupňů, zrnitostně středně těžké až 

velmi těžké, hlinitopísčité až jílovohlinité, bezskeletovité, středně až dobře 

odvodněné. 

55 Fluvizemě psefitické, arenické, stratifikované, oglejené, černice arenické, 

koluvizemě arenické na lehkých koluviálních a nivních uloženinách, s podložím písků 

nebo štěrků, bez skeletu až slabě skeletovité, výsušné. 

56 Fluvizemě modální a kambické eubazické až mezobazické, fluvizemě 

stratifikované včetně karbonátových a oglejených subtypů, koluvizemě modální, často 

s podložím hlinitopísčitým až jílovitohlinitým, bez skeletu až slabě skeletovité, vláhově 

příznivé se střední rychlostí infiltrace. 

57 Fluvizemě pelické a kambické eubazické až mezobazické, fluvizemě 

stratifikované, koluvizemě pelické, včetně karbonátových a oglejených subtypů na 
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těžkých nivních uloženinách, těžké až velmi těžké, bez skeletu až slabě skeletovité, 

vlhkostní poměry příznivé se sklony k převlhčení. 

60 Černice modální i černice modální karbonátové, černice arenické, černice fluvické 

na nivních uloženinách, spraši, lehčí středně těžké, bez skeletu, příznivé vláhové 

podmínky až mírně vlhčí. 

71 Gleje fluvické, fluvizemě glejové, černice fluvické glejové, fluvizemě glejové 

výrazně vlhčí, lehčí středně těžké až velmi těžké, bez skeletu až slabě skeletovité, při 

zvýšené hladině vody v toku trpí záplavami. 

4.2.3 Ochrana přírody 

Na jižním svahu Semické hůry jsou vyvinuta typická společenstva bílých strání 

s hojným výskytem druhů červeného seznamu, a tak společně s Přerovskou hůrou 

a Vrškem u Vestce tvoří přírodní památku a Evropsky významnou lokalitu soustavy 

Natura 2000 Polabské hůry (AOPK 2006). Přestože jsou společenstva bílých strání 

sukcesně poměrně stabilní, jsou porosty ohrožovány expanzí křovin. Pás při patě 

svahu Semické hůry je dosud extenzivně zemědělsky využíván. Současný 

management je občasné kosení lučních porostů, extenzivní pastva, redukce náletu 

a odstranění nevhodných výsadeb borovice černé (MÚ Lysá nad Labem 2016). 

Na severovýchodě katastrálního území se nachází přírodní rezervace Vrť, kde je 

hlavním předmětem ochrany zachování refugia rostlin a živočichů typických pro 

listnaté smíšené porosty původních lužních lesů a tůní v okolí Labe. V lokalitě byla 

ponechána neregulovaná slepá ramena řeky, která vytvořila unikátní biotop (Gerža 

2015). 

4.2.4 Hospodářské využití území 

Díky přítomnosti kvalitní úrodné nivní půdy již v období první republiky dosáhl rozkvět 

zemědělství v obci takového stupně, že se jen málo obcí v Polabí mohlo s ní 

srovnávat. Místní firma Bramko Semice je dnes největším pěstitelem brambor a další 

zeleniny v České republice. Firma Bramko je zapojená do certifikačního systému 

standardů pro zemědělskou produkci GlobalGap. Tyto standardy zaručují 

spotřebitelům, že zboží je vyrobeno v zemědělských provozech, které minimalizují 

škodlivé vlivy na životní prostředí a snaží se snižovat užívání chemických postřiků. 

Participace v GlobalGap zahrnuje roční inspekce zemědělců včetně neohlášených 

kontrol. Bramko je také zapojeno do programu integrované produkce zeleniny 

a brambor a v současné době usiluje také o přidělení značky Klasa. Integrovaný 

systém produkce zeleniny je produkce zeleniny vysoké kvality, která dává přednost 
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ekologicky přijatelným metodám a minimalizuje vstupy agrochemikálií s nežádoucími 

vedlejšími účinky. Přestože se řadí mezi konvenční produkci plodin, prosazuje snížení 

rizika přehnojování půdy a racionálnější využívání živin. Zelenina vypěstovaná v 

systému IPZ podléhá systematické kontrole nezávislého kontrolního orgánu (Obec 

Semice 2018; Družstvo BRAMKO CZ 2019). Tabulka 4 zobrazuje přehled všech 

pěstovaných plodin firmy Bramko. Tabulka zahrnuje kompletní výnosy firmy, ne 

pouze z k. ú. Semice nad Labem, ale z celé plochy firmou obhospodařované půdy. 

Poměry pěstovaných plodin jsou však odpovídající těm pěstovaným v k. ú. Semice 

nad Labem. 

Pěstovaná plodina Výměra (ha) 

Brambory 900 

Obiloviny 400 

Saláty 220 

Ředkvička 200 

Cibule 190 

Mrkev 150 

Petržel 125 

Dýně 100 

Kedlubny 80 

Celer 80 

Petržel 60 

Petržel svazek 60 

Česnek 60 

Zelí 10 

Pažitka 10 

Májová ředkev 10 

Meloun vodní 6 

Okurky nakládačky 6 

Petržel kudrnka 5 

Červená řepa 5 

Lilek 3 

Tabulka 4 Přehled pěstovaných plodin dle výměry (Družstvo BRAMKO CZ 2019) 

Na území se nachází 140 ha lesních pozemků. Hospodářské lesy jsou převážně ve 

vlastnictví fyzických osob anebo se jedná o lesy obecní. Lesy na území přírodní 

rezervace Vrť jsou kategorizovány jako lesy ochranné. Druhové složení lesů se liší 

dle lokality. V blízkosti Labe se nacházejí lesy listnaté, stejně jako v okolí Semické 
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hůry, kde se nachází i porost smíšený, kvůli druhům introdukovaným člověkem. Ve 

východní části k. ú. se pak nacházejí lesy jehličnaté, povětšinou čisté borovicové 

porosty (ÚHUL 2018).  

Katastrální území Semic navazuje na území Kerska, které je známou turistickou 

lokalitou a rekreační oblastí. Podél řeky Labe na severu území vede cyklostezka 

Labská stezka, která probíhá chatovou osadou. Tato rekreační lokalita je od zbytku 

území oddělena lužními lesy. Dle územního plánu (2018) není přípustné budovat 

v rekreační oblasti novostavby. 

Východně od intravilánu je v územním plánu vymezená lokalita pro těžbu štěrkopísku. 

Díky tomu je daná plocha nezastavitelná, pokud se nebude jednat o dočasné objekty 

nezbytné pro zajištění těžby. V současné době těžba ještě nebyla zahájena, ale po 

ukončení těžby musí být plocha rekultivována na les (Jirovský 2018). 
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5. Metodika 

5.1 Vstupní data 

Mapové podklady použité pro rozbor současného stavu, terénní průzkum 

a zpracování návrhu plánu společných zařízení a jejich zdroje vyobrazuje Tabulka 5. 

Mapový podklad Zdroj 

Katastrální mapa ČÚZK Data katastrální mapy ve formátu 

SHP a VFK 

ZABAGED 

ZM10 

Ortofotomapa 

ČÚZK Prohlížecí služby WMS 

DMR 5G (7 mapových listů) ČÚZK Služba zapůjčení dat studentům 

Ortofotomapa 50. let 

Mapa II. a III. vojenského mapování 

Mapy krajinného pokrytí a využití území 

CENIA Národní geoportál INSPIRE 

Půdní bloky 

Vodní útvary 

BPEJ 

MZe Veřejný registr půdy LPIS 

Lesy Geoportál ÚHUL 

Meliorace VÚMOP ISMS  

BPEJ VÚMOP eKatalog BPEJ  

Ohroženost vodní erozí 

Ohroženost větrnou erozí 

VÚMOP SOWAC GIS 

Územní plán Oficiální informační server města Lysá 

nad Labem 

Územně analytické podklady Zapůjčení dat stavebním úřadem města 

Lysá nad Labem 

Tabulka 5 Vstupní data 

Obec Semice má s účinností od 12. 10. 2018 platný územní plán (ÚP). Zpracovatelem 

ÚP byl Atelier M.A.A.T., s.r.o., zodpovědný projektant Ing. arch. Martin Jirovský, 

Ph.D., MBA. 

5.2 Terénní průzkum 

Pro přípravu terénního průzkumu byly využity základní mapy a ortofoto od ČÚZK. 

Průzkum byl veden dle Metodického návodu k provádění pozemkových úprav 

Státního pozemkového úřadu z roku 2016. Terénní šetření bylo provedeno za účelem 

http://services.cuzk.cz/shp/ku/
http://services.cuzk.cz/vfk
https://geoportal.cuzk.cz/(S(web52qk1xvd5mn5wc2wo0bkw))/default.aspx?mode=TextMeta&side=wms.verejne&text=WMS.verejne.uvod&head_tab=sekce-03-gp&menu=311
https://geoportal.gov.cz/
http://eagri.cz/public/app/lpisext/lpis/verejny2/plpis/
http://geoportal.uhul.cz/mapy/mapylhpovyst.html
https://meliorace.vumop.cz/?core=app
https://bpej.vumop.cz/
https://mapy.vumop.cz/
https://mestolysa.cz/cz/uzemni-planovani/uzemni-plan-semice/vydany-up-semice-s-ucinnosti-od-12-10-2018
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zjištění skutečného stavu využívání území z hlediska zemědělské výroby, krajinného 

rázu a všech dalších faktorů, které mohou ovlivnit návrh plánu společných zařízení. 

Během průzkumu byl zejména zjištěn aktuální technický stav a parametry 

komunikací, jako např. druh a stav povrchu, způsob odvodnění, směrové a sklonové 

poměry anebo přístup na pozemky, aby byla zajištěna polyfunkčnost systému polních 

cest. Bylo pozorováno, zda jsou v lokalitě patrné projevy vodní či větrné eroze, zda 

se tam vyskytují trvale zamokřené půdy a technický a funkční stav melioračních 

systémů a stav koryt vodních toků a vodních děl. Zaznamenán byl stav a rozmístění 

současných protierozních prvků a ÚSES – porostů zpevňujících svahy, doprovodné 

zeleně podél komunikací, remízky, větrolamy atp. V terénu byla pořízena 

fotodokumentace stávajícího stavu. 

5.3 Metodické postupy 

5.3.1 Cestní síť 

Základní návrh cestní sítě vznikl po studiu map II. a III. vojenského mapování, ortofoto 

mapy z 50. let a jejich srovnáním se současným stavem cestní sítě sledovaným na 

ortofoto mapě a v územním plánu. Při návrhu cestní sítě byl brán zřetel na fakt, že se 

jedná o území s nejúrodnější půdou v republice, a tak není žádoucí jakýkoliv zbytečný 

zábor navíc. Při terénním průzkumu tak zejména došlo k přezkoumání současného 

stavu cest a navržení rekonstrukce, kde bylo třeba.  

Cesty byly kategorizovány dle normy ČNS 73 6109. Při zpracování snímků byla 

použita vektorizace, neboli převedení cestní sítě do digitální podoby. Vektorizace 

probíhala v maximálním měřítku 1:5000, což je dostatečně podrobné hodnocení 

umožňující zachytit i prostorově nepatrné změny komunikací. Základem pro 

vektorizaci lesních a polních cest byly .shp vrstvy silnice23_l a silniceMU_l zachycující 

silnice II. a III. třídy, respektive místní a zpevněné účelové komunikace sloužící 

k obsluze zemědělských objektů. Tyto vrstvy byly pomocí nástroje Merge spojeny do 

jedné vrstvy, která byla následnou vektorizací obohacena o polní cesty. 

5.3.2 Erozní ohroženost půd 

Při vyhodnocování erozní ohroženosti půd bylo postupováno dle doporučení 

Metodického návodu KPÚ (2016). Byla využita metoda USLE aplikovaná v prostředí 

GIS, kdy finálním výstupem je rastrový mapový podklad zachycující dlouhodobou 

průměrnou ztrátu půdy G v t.ha-1.rok-1 na veškeré zemědělské půdě v katastrálním 

území. Teoretické základy rovnice erozní ohroženosti jsou vysvětleny v kapitole 3.2.2 

Protierozní opatření. 
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𝐆 = 𝐑 ∙ 𝐊 ∙ 𝐋 ∙ 𝐒 ∙ 𝐂 ∙ 𝐏 

Faktor erozní účinnosti přívalového deště (R) 

Průměrná roční hodnota R faktoru pro Českou republiku byla stanovena na základě 

analýzy dat shromažďovaných Českým hydrometeorologickým ústavem z různých 

měřicích hydrometeorologických stanic na R = 40 [MJ.ha-1.cm.h-1]. Tuto hodnotu je 

doporučeno využívat pro celé území ČR, protože odráží stav na zemědělsky 

využívaném území, kde se hodnota faktoru R pohybuje v rozmezí 30 až  

45 MJ.ha-1.cm.h-1 (Janeček et al. 2012). 

Faktor erodovatelnosti půdy (K) 

Náchylnost půdy k erozi je v univerzální rovnici definována jako odnos půdy ze 

standardního pozemku (délka 22 m, sklon 9 %) v [t.ha–1] na jednotku faktoru R  

[MJ.ha-1.cm.h-1]. Erodovatelnost půdy je závislá na textuře a struktuře ornice, obsahu 

organické hmoty a propustnosti půdního profilu. Pro účely této práce byl použit 

způsob určení K faktoru podle hlavní půdní jednotky (HPJ) bonitační soustavy půd. 

Hodnoty K faktoru jsou pro všechny HPJ z kapitoly 4.2.2 zaznamenány  

v Tabulce 6 

Kód HPJ 4 6 20 21 41 55 56 57 60 71 

K faktor 0,16 0,32 0,28 0,15 0,33 0,25 0,40 0,45 0,31 0,47 

Tabulka 6 K faktor dle HPJ (Janeček et al. 2012) 

Tyto hodnoty byly zaznamenány do nového sloupce atributové tabulky .shp souboru 

BPEJ, který byl součástí územně analytických podkladů poskytnutých městem Lysá 

nad Labem. Následně byl tento vektorový soubor převeden do rastrové vrstvy 

faktor_k pomocí nástroje ArcToolbox » Conversion Tools » To Raster » Polygon to 

Raster. 

Faktory délky a sklonu svahu (LS) 

Faktor délky svahu (L) vyjadřuje vliv nepřerušené délky svahu na velikost ztráty půdy 

erozí a faktor sklonu svahu (S) vyjadřuje vliv sklonu svahu na velikost ztráty půdy 

erozí. Faktory L a S jsou často počítány dohromady jako součin LS. Pro stanovení LS 

faktoru v této práci bylo využito nástrojů ArcGIS 10.6.1 a USLE2D, kde je LS faktor 

stanoven pro každý předem velikostně určený čtverec digitálního modelu terénu 

(DMT). 

DMT byl vytvořen na základě .xyz souborů digitálního modelu reliéfu České republiky 

5. generace (DMR 5G) zapůjčeného od ČÚZK. DMR 5G představuje zobrazení 

zemského povrchu v digitálním tvaru ve formě diskrétních bodů v nepravidelné 

trojúhelníkové síti (TIN) bodů o souřadnicích x, y, h, kde h reprezentuje nadmořskou 
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výšku ve výškovém referenčním systému Balt po vyrovnání. Model vznikl z dat 

pořízených metodou leteckého laserového skenování výškopisu území České 

republiky (ČÚZK 2016). 

Katastrální území Semice jsou pokryty mapovými listy BRAN29, BRAN38, BRAN39, 

BRAN48, BRAN49, CBRO30 a CBRO40. Pro přenesení dat do programu ArcGIS je 

třeba uložit .xyz soubory jako textový dokument .txt. Za pomocí nástroje ArcToolbox 

» Conversion Tools » To dBASE konvertujeme data do ArcGIS databáze .dbf. Jelikož 

pro převedení na DMT je možno použít pouze jeden vstupní soubor, je třeba spojit 

všechny mapové listy v jeden společný .dbt soubor dat; ArcToolbox » Data 

Management Tools » General » Merge. Takto sjednocená data lze graficky zobrazit 

pomocí File » Add Data » Add XY Data…, kdy vyplníme pozice souřadnic z naší 

databáze. X Field je x, Y Field je y a Z Field je z. Data dodaná ČÚZK jsou 

v koordinačním systému S-JTSK / Krovak Easth North, který je závazným 

geodetickým referenčním systémem na území ČR. Takto připravenou vrstvu bodů 

pomocí ArcToolbox » Conversion Tool » To Raster » Point to Raster převedeme na 

DMT. Value field je třeba změnit na z – data zachycující výškopis, Cell assignment 

type změníme na MEAN (průměr) a Cellsize na 5 (m). Cell assignment program 

používá v případě, že v jednom čtverci o velikosti Cellsize je více než jeden bod 

z dané databáze. Pokud ano, nastavením hodnoty MEAN zaručíme, že systém 

vezme průměr těchto hodnot z. Velikost Cellsize byla určena na 5 m pozorováním 

vzdáleností mezi lidarovými body. Takto připravený DMT je vstupní rastrovou vrstvou 

pro výpočet faktoru LS v programu USLE2D. 

Pro výpočet faktoru LS je třeba připravit také následující vektorová data: 

1. Hranice řešeného území (linie) 

•  .shp soubor hranic katastrálního území z webu ČÚZK 

2. Vodní toky a plochy (polygon) 

• dostupné v ÚAP jako VodUtPovT_p.shp a VodUtPovS_p.shp 

3. Lesy (polygon) 

• dostupný v ÚAP jako LesyKat_p.shp 

4. Zastavěná plocha (polygon) 

• dostupné v ÚAP jako ZastUz_p.shp 

5. Cestní síť (polygon) 

• dostupné v ÚAP jako Silnice23_p.shp a SilniceMU_p.shp 
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DMT i vektorové vrstvy zasahují za hranice k. ú. Semice. Data byla takto ponechána, 

jelikož je třeba výpočet provést s ohledem na reálné bariéry v krajině a není vhodné 

se omezovat pomyslnou hranicí k. ú. 

Program USLE2D vyžaduje pro výpočet LS faktoru jako vstupní data DMT a rastrovou 

vrstvu „parcel“. Tento rastr rozčleňuje řešené území na dílčí plochy. Výpočet vychází 

z předpokladu, že hranice mezi dílčími plochami působí jako překážky pro plošný 

povrchový odtok a dochází tu k přerušení odtoku, čímž se snižuje délka odtokové 

dráhy a faktor délky svahu L. Délka odtokové dráhy je ve výpočtu USLE2D nahrazena 

dílčím povodím čtverce rastru. Toto mikropovodí, neboli zdrojová plocha odtoku, je 

stanovená pro každý čtverec rastru DMT zvlášť. 

Vrstva parcel je grid, ve kterém je každému rastrovému elementu přiřazená číselná 

hodnota (celé číslo). Hodnota 0 znamená, že pro dané území LS faktor nebude 

počítaný, jelikož tu dochází k přerušení povrchového odtoku (např. vodní toky 

a plochy, cestní síť). Hodnota > 0 naopak znamená, že pro území je LS faktor počítán 

(orná půda, lesy). Na rozhraní mezi parcelami pak dochází k přerušení odtokové 

dráhy, např. na hranici lesa. 

Všechna výše jmenovaná zdrojová data přidáme do ArcMaps. Než začneme se 

samotným procesováním dat, je třeba nastavit správné prostředí. Nastavení 

Geoprocessing » Environments… » Processing Extent » Same as layer DMT a Raster 

Analysis » Cellsize » Same as layer DMT zaručí, že veškeré vytvořené rastry budou 

mít stejný územní rozsah a velikost čtverců jako právě dříve vytvořený DMT, což je 

důležité pro následný výpočet v USLE2D. 

Pro převod vektorových dat na rastr použijeme ArcToolbox » Conversion Tools » To 

Raster » Feature to Raster a jako políčko Field, jež přiřadí rastru hodnotu, vybereme 

takový atribut, který jednoznačně určuje každou linii nebo polygon. Jako další krok je 

třeba rozlišit, pro která území má USLE2D počítat LS faktor, a pro které ne. Začneme 

od vrstvy zemědělské půdy, pro kterou LS faktor počítat chceme. Pomocí ArcToolbox 

» Spatial Analyst Tools » Reclass  » Reclassify přiřadíme této vrstvě hodnotu 1. 

Vybereme možnost Classify a jako počet Classes vybereme 1. Tím zajistíme, že 

výsledná vrstva bude mít pouze jednu hodnotu. Pro NoData nastavíme hodnotu 0 

a reklasifikujeme rastr, viz Obrázek 6. Výsledkem je binární rastr. 
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Obrázek 6 Reklasifikace rastru 

Opačně postupujeme pro další vektorové vrstvy, pro plochy, kde LS faktor počítat 

nechceme – vodní toky a plochy, cestní síť, zastavěné území – přiřadíme datům 

hodnotu pro reklasifikaci 0 a plochám NoData přiřadíme hodnotu 1. Zvlášť 

reklasifikujeme vrstvu lesů. Tam plochám NoData přiřadíme číslo 1 a lesům číslo 2. 

Nástroj ArcToolbox » Spatial Analyst Tools » Map Algebra » Raster Calculator nám 

pomůže zkombinovat všechny nově vytvořené rastry. Výsledný grid parcel 

vypočítáme jako součin všech dílčích rastrů. Zemedelska_plocha * vodni_plochy * 

vodni_toky * komunikace * zastavene_uzemi * lesy. Takto docílíme vytvoření finálního 

rastru parcel, který bude vstupovat do USLE2D, kde orná půda má hodnotu 1, lesy 

hodnotu 2 a ostatní plochy hodnotu 0. 

Program USLE2D umožňuje pracovat pouze s daty ve formátu Idrisi, a tak je třeba 

převést připravený rastr do formátu .rst. Toto v ArcMap nelze udělat přímo, proto 

musíme nejprve data převést na textový soubor, a pak teprve do formátu Idrisi. Pro 

tuto potřebu použijeme funkci ArcToolbox » Conversion Tools » From Raster » Raster 

to ASCII. Takto je třeba převést oba soubory které budou vstupovat do USLE2D, a to 

rastry DMT a parcel. Pro převod textových souborů do formátu .rst použijeme volně 

dostupný program LS converter. První tlačítko slouží k převodu DMT, druhé pak pro 

převod rastru parcel (Obrázek 7). Výsledkem jsou dva soubory ve formátu .rst, které 

lze použít pro výpočet LS faktoru v USLE2D. 
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Obrázek 7 LS convertor 

Po nainstalování USLE2D je třeba kliknout na File » USLE2D. Jako první se vybírá 

vrstva DMT, jako druhá vrstva parcel. Výsledný soubor opět uložíme ve formátu .rst 

nebo .img, jedná se o stejný formát jako Idrisi. Soubor s vypočítaným LS faktorem je 

třeba převést zpět do textového formátu, který je čitelný pro ArcGIS. Pro tento účel 

použijeme třetí tlačítko v programu LS convertor. Obdobně jako jsme převáděli rastr 

na text, nyní formát převedeme zpět pomocí ArcToolbox » Conversion Tools » From 

Raster » ASCII to Raster. Jako Output data type zvolíme FLOAT, aby hodnoty rastru 

byly i s desetinnými čísly. 

Jako poslední úpravu je třeba provést odstranění extrémních hodnot. Většina 

liniových prvků na území, jako jsou cesty nebo vodní toky, mají menší hodnotu než je 

rozlišení rastru (5 m), a tak byl i vstupní rastr těchto vrstev zkreslený, nulové hodnoty 

po celé ploše rastru neodpovídají realitě. Pro korekci použijeme nástroj ArcToolbox » 

Spatial Analyst Tools » Neighborhood » Focal Statistics, kde jako Statistics type 

vybereme MEAN. Díky tomu si každý čtverec rastru vezme průměrnou hodnotu 

okolních čtverců, a zmírní se tak vliv extrémních hodnot. Takto máme vypočítanou 

výslednou vrstvu LS faktoru s názvem faktor_ls. 

Faktor ochranného vlivu vegetace (C) 

Pro potřeby této práce byl faktor C určen rámcově, dle průměrného zastoupení plodin 

v lokalitě, pomocí hodnot C faktoru uvedených v metodice Ochrany zemědělské půdy 

před erozí (Janeček et al. 2012). 

Průměrné zastoupení plodin bylo určeno dle výměry uvedené v kapitole 4.2.4 

Hospodářské využití území. Výpočet faktoru C znázorňuje Tabulka 7. 
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Plodina C faktor Podíl (%) Výsledný C faktor 

Brambory rané 0,6 12 0,0720 

Brambory pozdní 0,44 22 0,0968 

Obiloviny 0,14 15 0,0210 

Zelenina 0,45 51 0,2295 

   0,42 

Tabulka 7 Výpočet C faktoru 

Výsledný C faktor 0,42 je váženým průměrem výše uvedených hodnot. 

 

Faktor účinnosti protierozních opatření (P) 

Hodnota P faktoru je stanovena na P = 1, protože na daném území nejsou dosud 

přítomna žádná protierozní opatření. 

Erozní ohroženost (G) 

Pro dosazení výše vypočítaných faktorů do rovnice USLE byl použit nástroj Raster 

Calculator (Obrázek 8). Výsledný raster znázorňuje ztrátu půdy pro jednotlivé pixely. 

Proto bylo ještě třeba rastr upravit pomocí Zonal Statistics, abychom získali 

průměrnou ztrátu půdy pro jednotlivé zemědělské pozemky. Jako vstupní vrstva proto 

slouží Zem_puda, kde ID jednotlivých půdních bloků slouží jako jedinečný 

identifikátor. Do pole Input value raster vložíme rastr eroze. Aby výsledný rastr co 

nejlépe vyjadřoval vypočítaná data, pomocí Properties » Symbology zobrazíme data 

jako Classified. Třídy upravíme tak, aby bylo na první pohled možné odlišit přípustné 

hodnoty G od těch nepřípustných. Pomocí možnosti Classify a metody Manual 

upravíme třídy dle naší potřeby. 

 

Obrázek 8 Rovnice USLE 
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Míra ohrožení erozí byla klasifikována následovně: 

< 1 velmi slabě ohrožená 

1-2 slabě ohrožená 

2-4 středně ohrožená 

4-8 silně ohrožená 

8-10 velmi silně ohrožená 

> 10 extrémně ohrožená 

 

5.3.3 Hydrologie 

Návrh vodohospodářských opatření vychází především ze studia mapových podkladů 

a terénního šetření. Vzhledem k tomu, že se jedná o intenzivně zemědělsky 

obhospodařované území, je zde zásadní přítomnost odvodňovacích (HOZ) 

a závlahových (HZZ) zařízení. Tyto je třeba respektovat a zachovat jejich funkčnost, 

proto byly navrženy pouze revitalizace či rekonstrukce stávajících objektů, kde bylo 

třeba. 

Vodohospodářská opatření byla kategorizována následovně: 

Vodní plochy – veškeré vodní plochy stojaté i tekoucí, přírodního i antropogenního 
původu. 

Vodní toky – povrchové vodní toky přirozené i umělé (potoky, řeky, kanály).  

Meliorační zařízení – odvodňovací a závlahové stavby, otevřené a trubní. 

Podklady vodohospodářské sítě v .shp formátu byly poskytnuty v rámci územně 

analytických podkladů městem Lysá nad Labem. 

Dle platného územního plánu je třeba dodržet podmínky umožňující výkon správy 

a údržbu HOZ a HZZ. Podél trubních HOZ je třeba zanechat nezastavěný 

manipulační pruh o šířce 4 m od osy potrubí na obě strany a podél otevřených HOZ 

6 m široký oboustranný manipulační pruh (měřeno od břehové čáry).  

Provádění výsadeb okolo HOZ je možné, ale je třeba zachovat minimální vzdálenost 

1 m od břehové hrany otevřených koryt, pro trubní HOZ je to pak vzdálenost 

minimálně 4 m od osy zatrubnění. 

Navržené revitalizace mají za cíl být multifunkční, jsou proto navrhovány za účelem 

plnit nejen vodohospodářskou funkci, ale také protierozní a krajinotvornou funkci 

v rámci ÚSES. 
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5.3.4 Životní prostředí 

Návrh územního systému ekologické stability byl vesměs převzat z platného 

územního plánu. Byly vyhledány všechny prvky ÚSES (biocentra a biokoridory) 

nadregionální, regionální a lokální úrovně i s jejich navrženými úpravami oproti 

stávajícímu stavu. Platný územní plán v místech, kde je odchylka ÚSES od 

současného stavu krajiny, počítá se změnou využití plochy z orné půdy na plochu 

trvalého travního porostu v případě biokoridoru a na plochy nezastavěné přírodní 

v případě biocentra. Je ale zároveň nutné zajistit, že tato změna bude realizována 

pouze v nezbytném malém plošném rozsahu vůči této vymezené ploše a že změny 

budou přednostně umisťované mimo plochy v I. a II. třídě ochrany BPEJ. Plochy 

ÚSES jsou vždy nadřazené vůči ostatním plochám využití, které překrývají. 

Při návrhu byl kladen důraz na návaznost systému na okolní katastrální území 

a zajištění možnosti prostupnosti krajiny pro organismy, proto byla navržena řada 

interakčních prvků, které jsou téměř bez výjimky vymezeny na osách vodotečí. Tato 

navržená opatření zároveň fungují jako přirozené regulátory odtokových poměrů 

a zvyšují přirozenou retenční schopnost krajiny. Vzhledem k tomu, že se jedná 

o rovinaté území, jsou navrhované interakční prvky také žádoucím opatřením proti 

větrné erozi. 
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6. Rozbor současného stavu 

V katastrálním území Semice nad Labem je půda majoritně využívána k zemědělství. 

Téměř 68 % pozemků tvoří bloky orné půdy, zanedbatelný podíl z celkové výměry 

pak mají také trvalé travní porosty (2,5 %) a ovocné sady (0,13 %). Dohromady tak 

zemědělská půda zabírá více než 70 % plochy katastrálního území. Veškeré 

zemědělské aktivity zde probíhají výhradně v režimu konvenčního hospodaření, 

nenachází se zde žádný ekologický zemědělec. Zastoupení dalších typů pozemků 

zachycuje Tabulka 8. 

Obrázek 9 pak zachycuje stejná čísla, přičemž jsou hodnoty seřazeny od největší po 

nejmenší. Až na lesní pozemky, žádný další druh land use nedosahuje nad 10 % 

z celkové výměry 943 ha. Z ostatních ploch nejvíce rozlohy zaujímají manipulační 

a jiné plochy spojené se zemědělskou výrobou a také cestní síť, která je z důvodu 

dostupnosti parcel všem vlastníků poměrně hustá, jak je podrobněji popsáno 

v následující podkapitole 5.3.1 Cestní síť. 

Vodní plochy jsou převážně zastoupeny vodními toky, jelikož severní částí území 

protéká Labe a celé území je protkáno sítí umělých vodních toků a melioračních 

opatření. 

Druh pozemku Výměra (ha) Výměra (%) 

orná půda 636 67,43 

TTP 24 2,50 

ovocné sady 1 0,13 

lesní pozemky 140 14,86 

vodní plochy 50 5,28 

zahrady 17 1,82 

zastavěné plochy 19 1,96 

ostatní plochy 57 6,01 

CELKEM 943 100,00 
Tabulka 8 Statistické údaje ke dni 20. 10. 2019 (ČÚZK 2019)  

Tabulka 9 ilustruje velikosti pozemků obhospodařovaných jednotlivými uživateli dle 

registru LPIS. Téměř 70 % veškeré zemědělské půdy je v péči firmy Družstvo 

BRAMKO CZ (uživatelé Pavel Pokorný a Semická s.r.o.). 17 % pozemků (110 ha) 

pak vlastní Jan Procházka. Všichni ostatní jednotlivci či firmy pak užívají pod 5 % 

výměry, kdy 5 % odpovídá zhruba 30 ha půdy. 
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Obrázek 9 Využití pozemků v k. ú. Semice nad Labem 

Uživatel Výměra (ha) Výměra (%) 

Pavel Pokorný 393,99 59,61 

Jan Procházka 114,05 17,25 

Semická s.r.o. 54,25 8,21 

Zdeněk Moc 25,9 3,92 

Jaroslav Bodlák 20,32 3,07 

Luděk Bodlák 16,97 2,57 

Petr Aujeský 12,91 1,95 

Zahradnictví Jandl s.r.o. 10,47 1,58 

David Herdics 5,72 0,87 

Miloslav Pýcha 4,06 0,61 

Miloš Procházka 1,68 0,25 

Josef Jungr 0,68 0,10 

CELKEM 661 100,00 
Tabulka 9 Přehled uživatelů zemědělské půdy (LPIS 2019) 

6.1 Cestní síť 

Páteřní silnicí, která zasahuje do katastru Semic je silnice II. třídy č. 272. Silnice vede 

z Českého Brodu do Bělé pod Bezdězem. Na sever od Semic vede přes Lysou nad 

Labem, která je pro Semice obcí s rozšířenou působností. Na jih od Semic poskytuje 

přímé spojení s exitem 18 Bříství dálnice D11. Délka této silnice v k. ú. Semice je 

986 m. Silnice II/272 se zde kříží se dvěma silnicemi třetí třídy, a to III/2724 a III/2722. 

Silnice III/2724 propojuje křižovatku III/2722 a II/272 v bezprostřední blízkosti Semic 

se silnicí II/611, na kterou se napojuje za Přerovem nad Labem, mezi Starým Vestcem 

a Mochovem. Délka silnice v obvodu pozemkových úprav je 929 m. Silnice III/2722 

začíná na křižovatce s III/2724 a s II/272 a vede západovýchodním směrem 
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intravilánem Semic, dále pokračuje přes Hradišťko a ve městě Sadská se pak 

napojuje na silnici II/330. Délka silnice v ObPÚ je 3171 m. V intravilánu obce se na 

tuto silnici napojuje další silnice III. třídy, a to III/3308. Její délka je 1745 m. Spojuje 

obec Semice s obcí Poříčany, kde se napojuje na silnici I/330. 

Na silnice III. třídy navazují místní komunikace, které až na jednu výjimku vedou 

intravilánem obce. Místní komunikace o délce 410 m v extravilánu spojuje přímo 

silnice III/2724 a II/272 a umožňuje se vyhnout velké výše zmiňované křižovatce. 

Mimo výše uvedené cesty jsou v katastrálním území přítomné také užitkové 

komunikace a polní cesty. Tyto cesty slouží především k prostupnosti krajiny za 

účelem pojezdu zemědělské mechanizace a pro turistiku. Tyto cesty převážně 

navazují na místní komunikace, méně pak na silnice III. třídy a výjimečně na silnici II. 

třídy. Celkovou funkčnost polních cest lze až na výjimky klasifikovat jako plně funkční. 

Místy není přítomný vyhovující stav povrchu nebo jsou zanesené či zcela chybějí 

svodné příkopy. Celkově lze ale hustotu sítě polních cest uvažovat jako dostačující, 

jelikož zajišťuje přístup na všechny půdní bloky. 

HPC1 vede z intravilánu obce, kde navazuje na místní komunikaci, podél areálu firmy 

Bramko Semice směrem na jih. Jedná se o hlavní přístupovou cestu pro zaměstnance 

do areálu. Cesta je sjízdná autem, má parametry P 7,00/30, délka 505 m, živičný 

povrch s vystupujícím kameninovým podkladem. Cesta je doprovázena svodným 

příkopem SP1, kterým částečně vede trubní HZZ. Stav příkopu je nevyhovující, je 

zcela zarostlý travinami a není udržovaný. Doprovodnou zeleň tvoří javory (Acer sp.) 

a náletové křoviny. Na HPC1 navazují VPC1, VPC2 a VPC7. 

HPC2 navazuje na severovýchodní část intravilánu a vede severním směrem, kde se 

u Labe napojuje na DPC3. Jejím hlavním účelem je přístup k odloučené části 

intravilánu (penzion) a následné napojení na cyklostezku podél Labe. Je tedy 

převážně využívána pro jiné než čistě zemědělské účely. Technický stav cesty je 

vynikající (Obrázek 10). P 4,5/30, délka 1150 m, živičný povrch. Komunikace je 

doprovozena zpevněným svodným příkopem SP2 s lichoběžníkovým tvarem koryta. 

Doprovodnou zelení jsou švestkové (Prunus sp.) stromy. Čím více se cesta vzdaluje 

od intravilánu, mění se i její charakter blíže přírodnímu. Doprovodná zeleň se mění 

na lísky (Corylus sp.) a javory (Acer sp.) a svodný příkop SP2 je nezpevněný, 

zatravněný, plně funkční. U křížení s DPC4 se nachází propustek, kterým prochází 

HZZ (Obrázek 11). Dalšími komunikacemi, kromě DPC4, navazujícími na HPC2 jsou 

VPC3, VPC4 a již zmiňovaná DPC3. Na cestě se nacházejí objekty P5, P8 a M3 

(přehled cestních objektů viz Tabulka 10 na konci této kapitoly). 
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Obrázek 10 HPC2 

 

Obrázek 11 HZZ procházející pod HPC2 

HPC3 je paralelní cestou k HP2. Vede také severojižním směrem, propojuje intravilán 

obce s lesní cestou vedoucí podél řeky Labe. Cesta je doprovozena HZZ a je 

převážně bez doprovodné zeleně. P 5,00/30, délka 680 m, zpevněná štěrkopískem. 

Na HPC3 vyúsťuje VPC5 a také se kříží s HPC4. 

HPC4 začíná na stejné křižovatce s místní komunikací jako HPC3. Propojuje 

intravilán obce s PR Vrť, v níž se napojuje na lesní cestu. Je po ní vedena červená 

turistická značka. P 4,5/20 se štěrkopískovým povrchem o délce 914 m. Cesta 

prochází v těsné blízkosti Semického potoka, od kterého se za intravilánem odkloní 

a je vedena podél zatravněné meze, kde ji nedoprovází žádná vyšší zeleň. 

VPC1 je zpevněná štěrkopísková cesta, vedoucí od HPC1 směrem na jihozápad 

území. Hlavním účelem cesty je zpřístupnění pozemků v této oblasti. Povrch cesty je 

ve skvělém stavu. P 4,00/30, jednostranný doprovod ovocných stromů, třešní (Prunus 

sp.) a jabloní (Malus sp.), doplňuje zatravněnou mez prodlužující linii Semického 

potoka. Cesta je doprovozena HZZ. Délka cesty je 1970 m. Na cestě se nachází 

objekt M4. 

VPC2 je pokračováním HPC1 směrem na jih. P 4,00/30, štěrkový povrch ve výborném 

stavu. Účelem cesty je zpřístupnění zemědělské půdy. V sousedním katastru Starý 

Vestec se napojuje na jinou polní cestu. Délka cesty je 1294 m. Cesta je doplněna 

zelení, která plní funkci interakčního prvku ÚSES; jedná se o ovocné stromy se silně 

zastoupeným keřovým patrem (růže šípková, bez černý). Na cestě se nachází objekty 

P2, H1 a M3 a je doplněna svodným příkopem SP3. 

VPC3 navazuje těsně za intravilánem na HPC2. Cesta o délce 1150 m vede do 

Kerského lesa k Velenskému potoku. P 4,5/30 s nezpevněným, prašným povrchem. 
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Po celé její délce je doprovázena HZZ. Cesta nemá žádný příkop ani doprovodnou 

zeleň. 

VPC4 slouží plně ke zpřístupnění pozemků v severovýchodní části území. P 3,5/30 

je cesta zpevněná panely. Přesto je poměrně prašná, po většinu své délky (1192 m) 

není doprovozena zelení. Cestu doprovází HZZ a dochází ke křížení cesty s HOZ. 

Křížení je ošetřeno propustkem, který je funkční. Na cestě se nachází objekt P3. 

VPC5 je pravostrannou odbočkou z HPC3. Vede v centrální severní části území 

a slouží k zpřístupnění pozemků. P 5,00/20 má nezpevněný povrch a je silně 

podmáčená (Obrázek 12). Cesta je dlouhá 522 m, není zde přítomný žádný příkop, 

který by vlhkost odváděl. V sousedství cesty se nacházejí vzrostlé stromy, ale 

nejedná se o doprovodnou zeleň cesty, nýbrž přilehlého půdního bloku s trvalým 

travním porostem. 

 

Obrázek 12 VPC5 podmáčený povrch 

VPC6 se nachází v severozápadní části území a navazuje přímo na silnici II/272 

u křižovatky s místní komunikací. P 3,50/20 o délce 613 m slouží k zpřístupnění 

pozemků pro zemědělské stroje. Vede podél lesního porostu a v sousedním k. ú. 

Přerov nad Labem navazuje na další lesní a polní cesty. Panelová cesta vede lehce 

nad úrovní orné půdy, a tak dochází k zadržování vody na okraji pole (Obrázek 13). 

VPC7 je spojkou HPC1 a cesty DPC1 pod Semickou hůrou. P 4,00/20 

s nezpevněným zatravněným povrchem slouží k příležitostnému pojezdu 

zemědělských strojů. Slouží hlavně k zpřístupnění pozemku sadu a orné půdy. Ve 

své druhé části, kdy se sklon svahu začíná navyšovat, se cesta stáčí po vrstevnici 
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a plní tak částečně i protierozní funkci. Délka cesty je 410 m. Na cestě se nachází 

objekt P4 a svodný příkop SP4. 

VPC8 leží v západním cípu k. ú. Semice. P 4,50/30 o délce 223 m je zpevněná cesta 

s panelovým povrchem v dobrém stavu. Slouží k dopravní obslužnosti 

technologického zázemí orné půdy v sousedním katastru Přerov nad Labem. Je 

doprovozena hustým porostem náletových křovin. 

 

Obrázek 13 VPC 6 - hromadění vody na poli 

DPC1 Tato doplňková cesta vede po vrstevnici Semické hůry. Volně navazuje na 

DPC7. P 2,00/20 zpevněná štěrkopískovým povrchem je v dobrém stavu, vede přímo 

pod hranou lesního porostu a z druhé strany navazuje pozemek trvalého travního 

porostu. Délka cesty je 981 m. Cesta je doplněna svodným příkopem SP5, který 

významně zkracuje délku odtokové linie po hraně Semické hůry, a tak snižuje míru 

ohrožení erozí. 

DPC2 prodlužuje VPC2, oproti které je o něco užší. P 3,00/30 se štěrkopískovým 

povrchem má délku 609 m. Ve vedlejším katastru Starý Vestec se napojuje na lesní 

cestu. Doprovází ji hustý porost keřového a stromového patra, jedná se o náletové 

dřeviny. Její trasa kopíruje trasu HOZ a z druhé strany cesty také HZZ. Cestu 

doprovází svodný příkop SP6. 

DPC3 je cyklotrasou 0019 a zároveň po ní vede zelená turistická značka. Vede 

podélně s Labem v severní části území. Cesta není určena k pojezdu zemědělské 

mechanizace, ale slouží pro rekreaci. Mimo funkci cyklostezky také zajišťuje přístup 

do chatové oblasti. P 3,00/30 je 1605 m dlouhá a má zpevněný štěrkopískový povrch 



54 

v dobrém stavu. Doprovodnou zeleň tvoří vzrostlé topoly (Populus sp.). Navazuje na 

HPC2 a vede z ní DPC13. Na cestě se nachází objekt P7 a svodný příkop SP7. 

DPC4 navazuje na HPC2 a slouží k zpřístupnění pozemků. Nachází se 

v severovýchodní části území. Směrem od HPC2 je cesta na začátku zpevněná 

panely, dále nezpevněná. Záchytný příkop je pouze uměle vytvořený hlubší orbou na 

okraji pole. Cesta je doprovozena HZZ. P 3,00/30 má délku 537 m. Není přítomna 

žádná doprovodná zeleň. 

DPC5 slouží k propojení intravilánu s VPC5. P 3,00/30 je v dobrém stavu, má 

nezpevněný zatravněný povrch. Má délku pouze 124 m. Na cestě se nachází objekt 

P1 a svodný příkop SP8. 

DPC6 je zpevněná panelová cesta navazující na silnici III/2722 a slouží ke 

zpřístupnění přilehlého půdního bloku. Pokračuje pak dále do lesa. P 3,00/30 má 

délku 679 m a je v dobrém stavu. 

DPC7 plní funkci hlavní příjezdové cesty k prodejně firmy Bramko Semice. Je 

zpevněna zámkovou dlažbou a je 207 m dlouhá. P 3,00/30 přímo ústí na silnici 

III/3308 a je doplněná uměle vysazeným živým plotem. Na cestě se nachází objekt 

M2. 

DPC8 Hlavním účelem této cesty je zpřístupnění pozemků v jihovýchodní části území. 

Cesta vede podél odvodňovacího kanálu. Cesta má nezpevněný povrch a je 

v přiměřeném stavu. P 3,00/30 má délku 1024 m. Navazuje na silnici III/3308. Na 

cestě se nachází objekt H2 a je doplněna svodným příkopem SP9. 

DPC9 je spíše pěšinou. Cesta o šířce 2 m a délce 699 m není svým charakterem 

vhodná pro pojezd mechanizace. Jedná se o pěšinu vedoucí od severozápadního 

okraje intravilánu, kde se napojuje na místní komunikace. Po celé délce ji doprovází 

HZZ (Obrázek 14). Má doplňkovou protierozní funkci, jelikož rozděluje půdní blok 

o velikosti téměř 18 ha na dva menší. 
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Obrázek 14 DPC9 Pěšina s HZZ 

DPC10 je krátká, pouhých 92 m dlouhá cesta. P 3,5/30 je napojena na VPC8 a stejně 

tak slouží k zajištění dostupnosti technických zemědělských objektů. Jedná se o 

zpevněnou panelovou cestu. 

DPC11 slouží k zajištění přístupnosti pozemků. Napojuje se na místní komunikaci 

v intravilánu a pokračuje podél Semického potoka v délce 856 m. P 3,00/30 sdílí 

doprovodnou zeleň s potokem, jedná se o buky (Fagus sp.) a lísky (Corylus sp.). Ve 

své horní části je cesta zpevněná štěrkopískem, postupně přechází v nezpevněnou, 

zatravněnou. Na cestě se nachází objekt M1. 

DPC12 se napojuje na silnici III/3308. P 3,00/30 je nezpevněná cesta zajišťující 

přístup techniky na zemědělské pozemky. Nachází se v jižní části území a je bez 

doprovodné zeleně. Pouze na konci cesty je pár solitérních dřevin v remízku. Cesta 

je 357 m dlouhá. Na cestě se nachází objekt P6. 

DPC13 navazuje na DPC3 a slouží k přístupu k slepému rameni Labe na severu 

území. P 3,00/30 je nezpevněná zatravněná cesta doplněná zelení náletových dřevin, 

včetně vzrostlého akátu (Robinia sp.), a vrb (Salix sp.). Cesta má délku 382 m. 

Celkový přehled stávající cestní sítě zachycuje graficky Příloha 1 a tabulkově Příloha 

2 a Příloha 3. 
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Označení Objekt Komunikace Techn. Parametry Stav 

P1 Propustek DPC5 DN 400 mm vyhovující 

P2 Propustek VPC2 DN 300 mm zanesený 

P3 Propustek VPC4 DN 300 mm zanesený 

P4 Propustek VPC7 DN 300 mm zanesený 

P5 Propustek HPC2 DN 400 mm vyhovující 

P6 Propustek DPC12 DN 400 mm zanesený 

P7 Propustek DPC3 DN 300 mm zanesený 

P8 Propustek HPC2 DN 300 mm vyhovující 

H1 Hospodářský sjezd VPC2 DN 400 mm zanesený 

H2 Hospodářský sjezd DPC8 DN 400 mm zanesený 

M1 Most DPC11 Q50 vyhovující 

M2 Most DPC7 Q50 vyhovující 

M3 Most HPC1 Q50 vyhovující 

M4 Most VPC1 Q50 vyhovující 
Tabulka 10 Přehled objektů na cestní síti 
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6.2 Erozní ohroženost půd 

Dle metodiky vysvětlené v kapitole 5.3.2 Erozní ohroženost půd byla pomocí 

programů ArcGIS a USLE2D vypočítána erozní ohroženost půdy vodní erozí (G). 

Mapový výstup z tohoto výpočtu zobrazuje Příloha 4. Jedná se o teoretické ohrožení 

území počítající s průměrnými hodnotami z celého území. 

Tabulka 11 znázorňuje vzorové výpočty pro jednotlivé míry ohrožení přítomné na 

lokalitě. Sklon i délka svahu byly ve skutečnosti odvozeny z DMT a vypočítány pomocí 

programu USLE2D pro každý jednotlivý rastr. Nevýhodou této metody je, že 

neuvažuje přerušení délky svahu např. cestou se svodným příkopem. V tabulce je pro 

hodnotu L dosazena standardní délka 300 m. 

  R K L S C P G 

Extrémně ohrožené 40 0,33 0,3 8,54 0,42 1 14,20 

Silně ohrožené 40 0,32 0,3 3,38 0,42 1 5,45 

Velmi slabě ohrožené 40 0,32 0,3 0,6 0,42 1 0,97 
Tabulka 11 Potenciální míra ohrožení erozí. Vzorové lokality. 

Naprostá většina území není ohrožena vodní erozí (hodnoty G pod 1 t.ha-1.rok-1), 

jelikož se jedná o převážně rovinaté území. Jedinou výjimkou je jižní svah Semické 

hůry, kde je sklon svahu vyšší než 5°, v určitých místech lesního porostu až 20°. 

V ohroženém a extrémně ohroženém území (hodnota G přesahuje 4, respektive 10 

t.ha-1.rok-1) se dle LPIS nacházejí dva celé bloky zemědělské půdy a pět dalších 

půdních bloků je zasaženo částečně (Obrázek 15). 

 

Obrázek 15 Půdní bloky ohrožené erozí 
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Blok č. 9905/2 (Obrázek 16) přímo na jižním svahu se sklonem 8,54° je již nyní užíván 

jako trvalý travní porost. Blok č. 0901/1 na jihozápadním svahu Semické hůry se 

svažitostí 5,17° je ornou půdou. V registru LPIS je pro tento půdní blok vymezena 

řada agrotechnických opatření: 

a) Nutnost ponechání strniště sklizené plodiny na dílu půdního bloku do založení 

porostu následné jarní plodiny, 

b) podmítnutí strniště sklizené plodiny a jeho ponechání bez orby, 

c) ponechání půdy po pásovém zpracování do založení porostu následující jarní 

plodiny, nebo 

d) osetí dílu půdního bloku nejpozději do 20. září meziplodinou a zachování 

souvislého porostu meziplodiny nejméně do 31. října. 

Odtokové poměry tohoto půdního bloku jsou zároveň ovlivněny drenážním 

zavlažováním, stejně jako částečně ohrožené bloky 0901/15 a 0901/16. Tyto půdní 

bloky jsou zavlažovány kanálem vedoucím přes půdní bloky 0901/14 a 0901/18 

(Obrázek 17). 

 

Obrázek 16 Trvalý travní porost na půdním 
bloku 9905/2, v pozadí Semická hůra 

 

Obrázek 17 Půdní blok 0901/18 a hydrant 

vzdušník 

Díky profilu krajiny je větším problémem ohroženost zemědělské půdy větrnou erozí. 

Jedná se o území s velkými bloky orné půdy bez přítomnosti liniových vegetačních 

prvků. Míra ohrožení větrnou erozí byla ověřena pomocí portálu SOWAC GIS 

provozovaného Výzkumným ústavem meliorací a ochrany půd (Obrázek 18). Tento 

výpočet uplatňuje rozdílnou metodiku výpočtu odnosu pro lehké a těžké půdy. 

Nejohroženější půdy se nacházejí ve východní části území, kde se přirozeně 

nevyskytuje žádný vodní tok ani žádný vegetační liniový prvek, který by rozbíjel 

mozaiku krajiny a nacházejí se zde méně hluboké, podprůměrně produkční fluvizemě 

a regozemě s podložím štěrků a písků. V jihozápadní části území, kde se nacházejí 

ty neúrodnější půdní typy jsou půdy ohroženy pouze mírně, což je dáno zejména 
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hloubkou a těžkostí půdního profilu. Co toto území ohrožuje je opět velikost půdních 

bloků a nepřítomnost vegetačních prvků. V území na sever od intravilánu jsou půdy 

pouze náchylné k větrné erozi. 

 

Obrázek 18 Ohrožení větrnou erozí. Zdroj: VÚMOP SOWAC GIS 2019 

6.3 Hydrologie 

V lokalitě se nacházejí čtyři objekty klasifikované jako vodní plochy. Všechny se 

nacházejí v severní části území a jedná se o dvě slepá a dvě mrtvá ramena Labe. 

Tato ramena vznikla v důsledku vybudování opatření sloužících k lepší splavnosti 

Labe – stavba příčných objektů (jezů a zdymadel) a narovnání koryta. Mrtvé rameno 

je součástí PR Vrť, kdy bohužel dochází k jeho postupnému zazemňování, a tak dnes 

samotná vodní plocha již zabírá minimální plochu oproti té původní. Veškeré vodní 

plochy se vesměs nacházejí v bezprostřední blízkosti pozemků určených k plnění 

funkce lesa a jsou součástí RBC Niva Labe u Semic a Ostré. 

Koryto Labe je v katastrálním území dimenzováno tak, aby Q100 neohrozil zastavěné 

území obce Semice, přičemž pruh území o šířce cca 150–200 m jižně od Labe je 

záplavová oblast Q5 bez trvalé zástavby. Veškerá protipovodňová opatření 

znemožňují, aby Labe k. ú. Semice odvodňovalo. Hlavním vodním tokem ovlivňujícím 

hydrologický režim území je tak Semický potok 1-04-07-0390-0-00, který pramení 

v sousedním k. ú. Starý Vestec a ústí do Kounického potoka v k. ú. Přerov nad 

Labem. Plocha dílčího povodí Semického potoka je 11,63 km2. Koryto potoka je 

vesměs zarostlé travní vegetací (Obrázek 19). Dalším menším vodním tokem je 

Psárecký potok. Oba původně přírodní vodní toky jsou výrazně upraveny. Jsou 

vesměs zcela napřímeny, přirozené meandrování je v podstatě nepřítomné, koryta 
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jsou zahloubena a mají lichoběžníkový příčný profil. Toky V Záluží a Z Horky jsou 

antropogenního původu. Všechny tyto menší toky jsou přítoky Semického potoka. 

Říční síť vodních toků lze klasifikovat jako asymetrickou. 

 

Obrázek 19 Semický potok 

Vodní režim území je zásadním způsobem řízen člověkem. Zmíněné regulované 

vodní toky a vodní plochy doplňuje síť odvodňovacích a zavlažovacích kanálů. Až na 

jeden trubní HOZ nacházející se v jihovýchodní části území, jsou všechna ostatní 

HOZ otevřená. Tyto kanály často plní funkci svodných příkopů okolo polních cest. 

Všechna zařízení jsou v současnosti plně funkční, přestože některé z příkopů jsou 

částečně zanesené. HZZ jsou výhradně trubní (Obrázek 20). 

Přehled všech stávajících vodohospodářských prvků zobrazuje Příloha 6. 

 

Obrázek 20 Křížení trubního HZZ s otevřeným HOZ 
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6.4 Životní prostředí 

Současný stav prvků ekologické stability a prvků na ochranu přírody a krajiny byl 

vyhodnocen během terénního průzkumu na základě podkladů výkresu ÚSES 

územního plánu Semic.  

Ze zásad územního rozvoje středočeského kraje byly do ÚP převzaty následující 

prvky ÚSES. Délka a rozloha jsou vždy uváděny pouze v řešeném území Semic, 

přestože oba tyto prvky zasahují i do sousedních katastrálních území. Je tak zajištěna 

kontinuálnost systému. 

Číslo Název Typ Délka 

NBK 10 Stříbrný roh – Polabský luh Nadregionální biokoridor  3400 m 

 

Číslo Název Typ Rozloha 

RBC 349 Niva Labe u Semic a Ostré Regionální biocentrum 109,34 ha 

 

NBK 10 vede západovýchodním směrem přes centrální oblast Semického katastru. 

Přichází z vedlejšího k. ú. Přerov nad Labem a pokračuje do k. ú. Hradišťko u Sadské. 

Trasa koridoru vede přes zalesněnou část Semické hůry, podél Semického potoka až 

k zalesněným pozemkům v oblasti Kerska. Původní trasa koridoru vede přes 

oplocený zemědělský areál, který byl vystavěn v návaznosti na intravilán. V zájmu 

zajištění opravdové funkčnosti koridoru je v ÚP navržena změna trasy, která bude 

respektována v návrhové části PSZ. 

RBC 349 je vymezen převážně v nejsevernější části kolem Labe a zahrnuje kromě 

plochy vodního toku a jeho ramen také přilehlé lužní lesy v oblasti přírodní rezervace 

Vrť. Toto biocentrum tak na území Semic vytváří souvislý pás různé šířky podél hranic 

k. ú. na sever od centrální části území. 

Dále ÚP Semice vymezuje tři lokální biocentra, aby byly splněny maximální délkové 

parametry biokoridoru. 

Číslo Název Typ Rozloha 

LBC 1 Semická hůra Lokální biocentrum vložené do NBK 10 10,68 ha 

LBC 2 Semický potok Lokální biocentrum vložené do NBK 10 5,02 ha 

LBC 3 Ke Kersku Lokální biocentrum vložené do NBK 10 8,11 ha 
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LBC 1 je v celém svém rozsahu na území na pozemku určenému k plnění funkce 

lesa. Biocentrum je tak považováno za funkční a není třeba přistupovat k úpravám, je 

vhodné lesní ekosystém ponechat přirozené sukcesi. 

LBC 2 se nachází v blízkosti intravilánu mezi areálem zemědělského podniku 

a zástavbou obce. Je vymezeno v okolí soutoku Semického potoka s jedním 

z umělých koryt, sloužících jako HOZ. V současné době je plocha biocentra 

využívána jako orná půda (Obrázek 21). V okolí vodních toků je pak souvislejší 

stromový a keřový porost. 

LBC 3 je vymezeno ve východní části k. ú. ve vzrostlém lesním porostu za objektem 

fotbalového hřiště. Tento les je již součástí rozlehlého lesního komplexu Kerska a je 

plně funkční (Obrázek 22). 

V lokalitě se v současnosti nenacházejí žádné identifikované interakční prvky. 

Územní plán umožňuje zachování současného využívání pozemků a jakékoliv 

potenciální podmíněně přípustné změny nesmí snížit stabilizační funkci ÚSES, tzn. 

oproti platnému ÚP nelze měnit druh pozemků na ty s nižším stupněm ekologické 

stability. 

Celkový přehled současného ÚSES vyobrazuje Příloha 7. 



63 

 

Obrázek 21 LBC 2 Orná půda osetá rostlinou z čeledi brukvovitých. V pozadí vlevo vzrostlejší porost 
u Semického potoka a vpravo LBC 1 Semická hůra 

 

Obrázek 22 Okraj lesního porostu, ve kterém je vymezeno LBC 3 
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6.5 Vyhodnocení současného stavu 

Území disponuje poměrně hustou cestní sítí, přestože se v krajině nacházejí půdní 

bloky s velkou rozlohou. Vzhledem k tomu, že umístění současných cest se 

v porovnání s historickými mapami příliš neliší a systém plní svůj účel, tedy zajišťuje 

přístup na pozemky, navazuje na systém sousedních obcí a umožňuje prostupnost 

krajiny s ohledem na vedení turistických a cyklistických stezek, bude v rámci PSZ 

navrhována pouze jedna nová cesta. Bude tedy zejména projektována rekonstrukce 

některých stávajících cest tak, aby byla zajištěna jejich polyfunkčnost, tzn. aby cesty 

plnily také svou funkci ekologickou a půdoochrannou. 

Ohrožení vodní erozí je limitováno na pár půdních bloků pod Semickou hůrou, kde se 

již nyní nacházejí převážně trvalé travní porosty a území je ošetřeno melioračními 

kanály. PSZ se tedy spíše zaměří na omezení ohrožení větrnou erozí, neboť se jedná 

o otevřenou rovinatou krajinu. Terénním šetřením bylo zjištěno, že organizační 

a agrotechnická opatření jsou již využívána (Obrázek 23 a Obrázek 24), v rámci 

technických opatření tedy bude navržena výsadba nových stromů tak, aby plnily 

funkci větrolamů a zároveň naplňovaly svou ekologickou funkci a zapadaly do ÚSES. 

 

Obrázek 23 Ponechání posklizňových zbytků 
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Obrázek 24 Orná půda s vysetou meziplodinou 

Zásadním úkolem navrhovaného PSZ bude vypořádat se s vodohospodářskými 

opatřeními v krajině. Důsledkem napřímení toků dochází k zrychlenému odtoku vody 

z krajiny, a tak bude navržena jejich revitalizace. Pro zvýšení retenční schopnosti 

krajiny a zároveň pro zvýšení ekologické stability bude v souladu s územním plánem 

navržena malá vodní nádrž v těsné blízkosti intravilánu. V rámci opatření k odvádění 

povrchových vod z území budou revitalizovány existující svodné příkopy. HOZ a HZZ 

nebudou v návrhu PSZ zahrnuty, nicméně bude navrženo jejich zatravnění 

a revitalizace, aby primárně docházelo ke zvýšení retenční schopnosti půdního profilu 

nebo naopak ke zlepšení půdních vlastností na zamokřených pozemcích. 

Územní systém ekologické stability bude plně převzat z územního plánu, včetně 

navrhovaného upravení trasy biokoridoru. Bude navržena revitalizace LBC 2 

a doplnění systému interakčními prvky pro zvýšení celkové funkčnosti ÚSES. 

Celkový přehled současného stavu všech výše zmíněných částí PSZ znázorňuje 

Příloha 8 Rozbor současného stavu. 
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7. Výsledky 

Veškeré poznatky uvedené v kapitole 6. Rozbor současného stavu budou zohledněny 

při návrhu plánu společných zařízení tak, aby zabezpečily naplnění hlavních cílů 

komplexních pozemkových úprav, a to zajištění přístupnosti pozemků, ochranu 

půdního fondu, optimalizaci odtokových poměrů a zvýšení ekologické stability krajiny. 

Navrhovaný PSZ pro k. ú. Semice nad Labem je plně v souladu s platnou územně 

plánovací dokumentací. Vzhledem k tomu, že nový územní plán byl vytvořen přímo 

za účelem KoPÚ, není třeba navrhovat žádnou změnu využití pozemků. Veškeré 

návrhy jsou limitovány vlastnickými vztahy, pro zvýšení pravděpodobnosti jejich 

realizace by tak měly být pozemky pod navrhovanými společnými zařízeními v rámci 

řízení KoPÚ převedeny do vlastnictví obce, pokud již v jejím vlastnictví nejsou. Obec 

v katastrálním území disponuje dostatečným množstvím parcel, včetně parcel 

zemědělského půdního fondu (Obrázek 25). 

Výměra pozemků potřebných pro vybudování nových společných zařízení činí celkem 

31,87 ha. Detaily obsahuje Tabulka 12. 

 

Obrázek 25 Modře vyznačeny pozemky ve vlastnictví obce (ČÚZK 2019a) 
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Na území se také nachází několik málo parcel ve vlastnictví státu, jedná se převážně 

o koryta vodních toků, přirozených i HOZ (ČÚZK 2019b). V případě potřeby lze pro 

společná zařízení využít také tuto výměru. 

Druh opatření Výměra (ha) 

Opatření sloužící ke zpřístupnění pozemků 0,22 ha 

Protierozní opatření na ochranu ZPF 15,99 ha 

Vodohospodářská opatření 1,03 ha 

Opatření k ochraně a tvorbě životního prostředí 14,63 ha 

Tabulka 12 Přehled výměr dle jednotlivých opatření 

7.1 Návrh opatření ke zpřístupnění pozemků 

Současná hustota cestní sítě byla vyhodnocena jako v zásadě dostatečná, pouze je 

třeba vybudovat jednu novou účelovou komunikaci a pár cest nebo objektů na nich 

rekonstruovat. Nově navrhovaná cesta, stejně jako ostatní nově navrhované prvky 

z této kapitoly, jsou graficky znázorněny na mapě (Příloha 9). 

Účelem nově navrhované cesty VPC9 je zvýšení prostupnosti krajiny a vyvedení 

pojezdu zemědělské techniky z intravilánu obce. Cesta propojuje stávající 

komunikace VPC2 a DPC12, je vedena po pomyslné linii nově navrhovaného úseku 

ÚSES podél jižní části zemědělského družstva. Návrhová kategorie je jednopruhová 

zpevněná P 3,5/30 s živičným povrchem, kdy odvodnění vozovky bude řešeno 

příčným sklonem vozovky do okolního terénu. Cestu je vhodné pro klid v území od 

navrhovaného biokoridoru oddělit stromořadím, které bude zároveň sloužit jako 

interakční prvek a odhlučnění. Doporučenou dřevinou k výsadbě jsou ovocné stromy, 

aby nová cesta harmonicky doplnila stávající krajinný ráz. Délka navrhované cesty je 

626 m. 

První stávající objekt určený k rekonstrukci se nachází na HPC1. Nevyhovujícím 

prvkem cesty je její svodný příkop. SP1 je zarostlý travinami, stejně tak jako propustek 

P4, kterým svodný příkop prochází při křížení s VPC7. Navrhuje se jeho vyčištění, 

nicméně jedná se o SP nezpevněný, a tak je žádoucí ponechat souvislou vrstvu drnu, 

doporučuje se tedy úprava sečením. 

VPC5 byla vyhodnocena jako silně podmáčená a je navrhována štěrková úprava 

povrchu oproti současnému nezpevněnému. Cesta je v rámci vodohospodářských 

opatření navrhována v koruně malé vodní nádrže. Odvodnění cesty je řešeno v rámci 

osázení hráze vegetací. 
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Dalším nevyhovujícím prvkem jinak funkční cestní sítě je odvodnění cesty VPC6. 

Jelikož se cesta nachází v bezprostřední blízkosti orné půdy s nejvyšší třídou 

ochrany, jediným doporučením je vytvořit úzký zasakovací travní pás pro usnadnění 

infiltrace vody do půdy. 

Jako management následné péče o polní cesty se doporučují pouze běžná opatření. 

Pro cesty v kategorii hlavní a vedlejší polní cesta se navrhuje shodná údržba jako ta, 

která je uplatňována u místních komunikací. Zásadní je pravidelná údržba 

zatravněných povrchů nejen na polních cestách, ale také u doprovodných objektů, 

jako jsou svodné příkopy a propustky. Je nutná pravidelná kontrola jejich stavu 

alespoň 2x ročně. 

7.2  Návrh protierozních opatření 

Z důvodu nízkého ohrožení území vodní erozí jsou navrhované objekty zaměřené 

především na boj s erozí větrnou. Nicméně ty, díky své všestrannosti, také zajistí 

zasakování vody do půdy přímo na pozemcích. 

V oblasti potenciálního kritického ohrožení půdy vodní erozí se již dnes nachází 

zatravněný pozemek, jehož spodní hranice je doprovozena příkopem SP5 podél 

DPC1, který vodu bezpečně odvádí po vrstevnici do svodného příkopu SP1 

vedoucího souběžně s HPC1. Po dosazení hodnot do rovnice USLE náležících 

konkrétnímu zatravněnému pozemku č. 9905/2, dostaneme hodnotu G <1 

(Tabulka 13), tudíž ani tento nejexponovanější pozemek na jižním svahu Semické 

hůry není přímo ohrožený. Mapu erozní ohroženosti celé lokality po zohlednění 

používání uplatnění protierozních opatření zachycuje Příloha 5. 

 Číslo pozemku R K L S C P G 

9905/2 40 0,33 0,03 8,54 0,005 1 0,02 

0901/18 40 0,32 0,188 3,38 0,45 0,6 2,20 

0901/17 40 0,31 0,2 0,6 0,45 1 0,67 
Tabulka 13 Míra ohrožení vodní erozí na vzorových půdních blocích po uplatnění opatření 

Kvůli omezení ohrožení území větrnou erozí jsou navrhovány větrolamy podél 

liniových prvků v krajině, tzn. podél existujících cest, vodních toků a meliorační sítě, 

v místech, kde v současnosti doprovodná zeleň chybí, tak, aby byly zmenšeny plochy 

odnosu půdy. Pro zaručení poloprodouvavosti větrolamu budou stromy doplněny keři, 

které zabrání přízemnímu proudění větru a odnosu půdních částic. Nová stromořadí 

jsou zároveň interakčními prvky, jelikož plní funkci v rámci systému ÚSES. Přesná 

skladba dřevin je vymezena v kapitole 7.4. 
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7.3 Návrh vodohospodářských opatření 

Hlavním záměrem v oblasti vodohospodářských opatření je využití dosud obtížně 

obhospodařovatelných zamokřených pozemků v současnosti obhospodařovaných 

jako trvalý travní porost k vybudování neprůtočné boční malé vodní nádrže na 

Semickém potoku s funkcí zásobní, rekreační a ekologickou. Realizací tohoto tělesa 

lze dosáhnout všech pozitivních vlivů vodního rezervoáru v krajině – zlepšení 

hospodaření s vodou, posílení malého vodního cyklu, zvýšení rozmanitosti 

a ekologické stability krajiny. Nádrž je navržena na glejové půdě s BPEJ 2.71.01, 

která je vyhodnocena jako velmi vhodná ke stavbě nádrží. Jedná se o půdu s nízkým 

stupněm ochrany, jež je velmi málo produkční a zároveň velmi málo propustná. 

Půda vytěžená při zahlubování nádrže může být použita na stavbu těsnící vrstvy 

nehomogenní sypané hráze, kdy při jejím zonálním uspořádání bude vytěžená 

zemina umístěna na návodné straně hráze a vzdušná stabilizační část bude doplněna 

štěrkem (Obrázek 26). Na rozhraní vrstev bude umístěna filtrační vrstva. Docílí se  

tak maximální nepropustnosti hráze. Hráz je navrhována jako boční, nepravidelná, po 

jejíž koruně o šířce min. 3,5 m povedou stávající cesty VPC5 a DPC5 sloužící pro 

občasný pojezd. 

 

Obrázek 26 Nehomogenní hráz s těsněním na návodní straně hráze navazující na nepropustné podloží 

(Frühbauer 2017) 

Základem stabilizace vzdušného svahu hráze je osetí travní směsí položením na 

humusovou vrstvu. Na stabilizační štěrkovou vrstvu musí být nejprve položena ještě 

vrstva filtrační. Navrhováno je osetí technickou směsí. Návodní svah pak bude 

osazen polovegetačními tvárnicemi rovněž osetými travinami. Pro méně exponované 

násypy vytvořené při terénních úpravách podél toku a v západní části nádrže je 

navrhováno osetí květnatou směsí lučních travin a bylin s doplňujícím krajinářským 

účinkem. Jako výpustné zařízení je projektován uzavřený betonový požerák 

o průměru DN 400 s dřevěnou přístupovou lávkou a spodním odtokem. 
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Pro samotnou realizaci vodního díla a jeho dimenzí je třeba vypracovat projekt 

založený na exaktních hydrologických a hydrotechnických výpočtech a musí dojít 

k posouzení bezpečnosti vodního díla při povodni. 

Dalším navrhovaným záměrem v oblasti vodohospodářství je revitalizace vodních 

toků a otevřených HOZ. Vodní toky je třeba uvést zpět do přírodě blízké podoby, což 

bude mít díky navrhovanému meandrování za následek větší retenční kapacitu 

a vyšší samočistící schopnost toku. Doplněním zeleně dojde také k zvýšení estetické 

hodnoty vodních toků v krajině a ke zvýšení atraktivity lokalit pro živočichy. 

S ohledem na okolní všudypřítomnou ornou půdu je revitalizované koryto navrhováno 

s nižší kapacitou Q5. Příkladem revitalizace pro k. ú. Semice nad Labem může být 

revitalizace realizovaná v k. ú. Vesec u Jičína v roce 2017 (Obrázek 27), kde byla 

revitalizace také zasazena do zemědělsky využívané krajiny. 

 

Obrázek 27 Revitalizace HOZ ve Vestci u Jičína (Pulkrábek 2017) 

Celkově je v řešeném území navrhováno 11 úseků (R1 – R11) k revitalizaci v celkové 

délce 4,6 km. 

Na pozemku se také nachází devět svodných příkopů, jejichž stav byl již popsán 

v kapitole 7.1. 



71 

7.4  Návrh opatření k ochraně a tvorbě životního prostředí 

Z důvodu zásahu původní trati biokoridoru do zastavěného území, byla střední část 

trasy územním plánem upravena. Nový koridor vede v bezprostřední blízkosti toho 

původního, ale vyhýbá se zastavěnému území. Z důvodu dostatečného množství 

biocenter není vymezeno žádné dodatečné. Nicméně se navrhuje úprava využití 

LBC2 oproti stávajícímu stavu. Je třeba plochu dostat do podoby více přírodě blízké, 

jelikož se už tak nachází velice blízko zastavěné oblasti. 

Řada liniových prvků – vodních toků, cest a melioračních kanálů byla doplněna 

trvalým zatravněním, což napomáhá retenci vody v krajině. Ty liniové prvky, které 

zatím neměly stávající doplňkovou zeleň, byly doplněny o stromořadí dřevin, které 

slouží jako interakční prvky, ale zároveň také jako větrolamy při ochraně před větrnou 

erozí. Základní kostrou této nové výsadby budou javor (Acer sp.) a ořešák (Juglans 

sp.). Doplňkové dřeviny pak budou ovocné stromy, a to jabloň (malus communis), 

hrušeň (Pirus communis) a třešeň (Prunus avium). Základní dřeviny zaručí 

dlouhověkost porostu, zatímco doplňkové dřeviny svým opadem zlepšují obsah živin 

v půdě. V doplňujícím keřovém patře bude využit ptačí zob a růže šípková. Funkce 

interakčního prvku je splněna tím, že nová stanoviště mohou sloužit jako hnízdiště 

ptáků a úkryt pro zvěř. 

V prvních týdnech či měsících od setby či zasazení bude nový porost pravidelně 

zaléván a hnojen. Další povýsadbová péče o nově založený porost bude spočívat 

v pěstební úpravě vedoucí ke zkvalitnění růstu, ochraně před buření (např. použitím 

geotextilie), v ošetření porostů proti škůdcům (postřiky) a ochraně proti okusu zvěří 

(oplocení dřevěnými sloupky), a to minimálně 2x ročně po dobu tří let od výsadby. Po 

této době se předpokládá, že výsadby jsou již dostatečně zajištěny. Dosadby za 

uhynulé rostliny budou prováděny stejným druhem; příp. dosadby se provádí každým 

rokem dle zjištěných skutečností. Ochranu proti zaplevelení je žádoucí provádět 

jednorázovým posečením a mulčováním travní hmotou (ponecháním na místě). Při 

extrémních teplotách je třeba zajistit zálivku pro vysokokmenné stromy. 

Samozřejmostí je pravidelné sečení (alespoň 2x ročně) všech zatravněných ploch 

s cílem vypěstování pevného a soudržného drnu. 

Doprovodná zeleň bude realizována v minimální vzdálenosti 1,5 m od svodného 

průlehu a minimálně 2 m od otevřených koryt HOZ. Stromořadí nejsou navrhována 

v blízkosti trubních HZZ, aby nedocházelo k jejich porušování. Celková délka 

navrhovaných stromořadí je 1100 m. 
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8. Diskuse 

V důsledku politického uspořádání Československa a ideologie intenzivního způsobu 

hospodaření mezi léty 1950 a 1990 lze sledovat markantní nárůst v průměrné velikosti 

půdního bloku. Tento trend lze rozhodně odůvodnit znárodňováním a scelováním 

pozemků za účelem obhospodařování půdy zemědělskými družstvy místo jednotlivci 

(Hájek 2008). Tento fakt dále vedl k vylidňování venkova a zpřetrhání vztahů 

vlastníka k obdělávané půdě, a došlo tak díky zaměření na produkční funkci krajiny 

k zásadní devastaci zemědělského půdního fondu vodní i větrnou erozí. Tato 

degradace krajiny měla za následek snížení biodiverzity a narušení ekologické 

stability krajiny (MZe 2010). 

Následkem vyvlastňování a následného procesu restitucí se sice původní vlastníci 

nebo jejich potomci dostali zpět ke svému osobnímu vlastnictví, mírou nepřehlednosti 

situace však byly pozemky ne vždy navraceny na původních lokalitách. Jejich často 

nelogické uspořádání nebo dokonce úplná nedostupnost pozemku vedly k tomu, že 

i takovým vlastníkům, kteří chtěli znovu začít hospodařit, to bylo okolnostmi 

v podstatě znemožněno. Vlastníci tak ve velkém pronajímali pozemky zpět velkým 

zemědělským podnikům. V dnešní době je tak více než 74 % zemědělské půdy 

v České republice pronajímáno (MZe 2018). Pozemkové úpravy jsou jedinečným 

nástrojem, jak tuto situaci zlepšit. Proces pozemkových úprav komplexně řeší jak 

upravení vlastnických vztahů, tak krajinotvorných opatření. 

Ve výsledném návrhu plánu společných zařízení je akcentována zejména potřeba 

obnovení přirozené retenční schopnosti půdy a zajištění zadržení vody v krajině, 

omezení větrné eroze a vnesení některých přírodě blízkých prvků do intenzivně 

využívané zemědělské krajiny. 

Díky zadržování vody v krajině lze předcházet vzniku povodní (Mazín 2014). Vodní 

toky v lokalitě byly dříve napřímeny a byla zde vybudována umělá koryta pro 

odvodnění. Na druhou stranu k. ú. Semice patří mezi pouhá 4 % půdy ZPF (MZe 

2018), kde je přítomna hustá síť zavlažovacích kanálů, a tak nejen v období sucha 

nejsou místní zemědělci závislí pouze na srážkových vodách. Nevýhodou všech 

takovýchto antropogenních zásahů do vodního režimu krajiny jsou náklady na údržbu 

systému. Pokud meliorační opatření přestanou být funkční, mohou krajině spíše 

uškodit. Zásadním nedostatkem je problematika evidence existence těchto staveb 

a chybějící projektová dokumentace k nim (Batysta et al. 2014). 

Ohrožení orné půdy erozí bylo pro vodní erozi vypočítáno v prostředí geografického 

informačního systému ArcGIS. Přesnost výpočtu by mohla být ještě vyšší, kdyby 
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faktor C nebyl vzat jako průměr všech pěstovaných plodin, ale kdyby byl přiřazen 

každé plošce zvlášť, nicméně vzhledem k faktu, že území je vodní erozí ohroženo 

pouze na lokální úrovni, nehraje toto zobecnění ve výpočtu zásadní roli. Ohrožení 

půdy erozí je v současnosti díky globálně se měnícím klimatickým podmínkám často 

skloňovaným předmětem společenských diskusí. V rámci legislativních opatření se 

chystá nové nařízení vlády, které dle vyjádření ministra zemědělství Tomana pro 

Novinky.cz (Novotný 2019) předpokládá, že od roku 2021 nebude možné pěstovat 

monokultury na ploše větší než 30 ha. Průměrná velikost půdních bloků od roku 1948 

vzrostla o téměř stonásobek z 0,23 ha na dnešních 20 ha (Sklenička & Šálek 2008). 

Z pohledu autorky této práce jsou dnešní legislativní opatření v České republice 

nedostatečná a jen minimálně podporují péči o mimoprodukční funkce krajiny. Plán 

společných zařízení je tak zatím tím nejúčinnějším nástrojem, jak českou krajinu 

ozdravit. 

Poměrně velký prostor je věnován prvkům systému ÚSES a jeho interakčním prvkům. 

Střídání bloků orné půdy, lesních porostů a vodních ploch je doplněno řadou liniových 

prvků, jako jsou doprovodná stromořadí polních cest, zatravněné pásy a meze podél 

zavlažovacích kanálů. Tyto prvky obohacují krajinu o vzácná ekotonální společenstva 

a druhy malých savců a ptáků, které bývaly pro zemědělskou krajinu typické, např. 

koroptve, bažanti nebo zajíci (Sklenička 2003). Zde ještě více než u předchozích 

odstavců je třeba zdůraznit nedostatečnou legislativní úpravu problematiky dotačních 

titulů v zemědělství, jelikož ochota vlastníků půdy umístit na svůj pozemek ekologicky 

stabilnější, nicméně mimoprodukční biotop, je téměř nulová. Je třeba, aby vlastníci 

půdu přestali pouze využívat, ale začali o ni také pečovat. I z tohoto důvodu jsou 

v práci ukázána mnohá opatření na úkor záboru půdy, která by posílila fungování 

krajiny jako komplexu, přestože se jedná o nejúrodnější půdu v republice. 

Tato diplomová práce se zaměřila čistě na samotný návrh společných opatření, nebyl 

brán zásadní zřetel na majetkoprávní uspořádání v lokalitě a nové krajinné prvky byly 

navrženy v místech, které se jevily jako nejvíce vhodné krajinářsky. Tento přístup byl 

zvolen z důvodu, že při návrhu byl vždy plně respektován platný územní plán 

a z katastru bylo zjištěno, že obec disponuje dostatečnou výměrou pozemků 

k případné směně. Nový územní plán byl vytvořen v roce 2018 přímo za účelem 

zahájení procesu komplexních pozemkových úprav. Při zpracování plánu byla 

vypořádána řada námitek vlastníků pozemků i obce. V problémových návrhových 

lokalitách, jako je např. nově navrhovaná trasa nadregionálního biokoridoru, je 

v nejzazším případě možnost z důvodu vyššího obecného zájmu pozemky vyvlastnit. 

Primárně by ovšem měly být pozemky pod nově navrhovanými prvky společných 
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zařízení v rámci procesu KoPÚ převedeny do vlastnictví obce, aby byla garantována 

možnost jejich realizace a předešlo se majetkoprávním sporům, ke kterým by 

vyvlastňování mohlo vést.  
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9. Závěr 

Hlavním cílem této diplomové práce byl návrh plánu společných zařízení komplexních 

pozemkových úprav v katastrálním území Semice nad Labem. Byla vypracována 

literární rešerše, která slouží k přiblížení problematiky pozemkových úprav 

a vypracování plánu společných zařízení v prostředí geografických informačních 

systémů. 

Zásadní složkou práce je kapitola rozboru současného stavu lokality. Pokud by nebyl 

proveden podrobný terénní průzkum a prostudování územně analytických podkladů 

a územně plánovací dokumentace, byl by následný návrh velmi teoretický a jen těžko 

uplatnitelný v praxi. Na základě vysledovaných nedostatků byla navržena nápravná 

opatření v rámci návrhu cestní sítě, protierozních a vodohospodářských opatření 

a opatření k ochraně a tvorbě životního prostředí. 

Katastrální území Semice nad Labem je, co se týče kvality orné půdy, jedno 

z nejcennějších území Česka. Plán společných zařízení zpracovaný v této práci 

k tomuto faktu přihlíží, nicméně přesto poukazuje na zásadní možnosti posílení 

mimoprodukčních funkcí krajiny. Cestní síť byla doplněna a rekonstruována tak, aby 

byla zajištěna prostupnost krajiny nejen v rámci řešeného k. ú., ale s návazností na 

okolní komunikace. Navržení nové polní cesty výrazně sníží vjezd zemědělské 

mechanizace do intravilánu obce. Veškeré prvky jsou navrženy tak, aby byly 

polyfunkční, a byl tak zajištěn co nejmenší zásah do stávajícího uspořádání. Cestní 

síť byla doplněna dalšími liniovými prvky jako jsou stromořadí a zatravněné meze, 

což jsou opatření napomáhající v prevenci negativního účinku větrné eroze a doplňují 

systém ÚSES. Díky charakteru krajinného profilu není 95 % území ohroženo vodní 

erozí a na zbývajících 5 % jsou důsledně uplatňována organizační a agrotechnická 

opatření. V rámci vodohospodářských úprav jsou navrhovány revitalizace stávajících 

vodotečí a výstavba nové malé vodní nádrže. Nedostatečné zadržování vody a její 

rychlý odvod z oblasti byl zásadním problémem, na jehož potlačení se zaměřuje 

většina navrhovaných prvků. Poměrně velká část rozlohy území je věnována 

objektům ÚSES. Je to dáno zejména přítomností přírodě blízkého lužního lesa 

v blízkosti Labe a krajinnou dominantou Semické hůry. Nově navržená trasa 

biokoridoru je vedena tak, aby byla zajištěna jeho prostupnost pro migrující živočichy. 

Trasa biokoridoru je proložena třemi lokálními biocentry. Všechny nově navrhované 

prvky společně s těmi stávajícími tvoří funkční síť, která zvyšuje ekologickou stabilitu 

krajiny a zvyšují její estetickou hodnotu. 
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Tato diplomová práce může být využita jako podklad v již zahájeném procesu 

komplexních pozemkových úprav nebo při návrhu strategických dokumentů v oblasti. 

V návaznosti na tuto práci je vhodné vypracovat projektovou dokumentaci k návrhu 

malé vodní nádrže a revitalizace vodních toků a HOZ a zpracovat přehled 

vlastnických poměrů pozemků. Dále se navrhuje provést hydrogeologický průzkum 

za účelem přesného zmapování melioračních opatření. 
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11. Přílohy 

Příloha 1 Přehled cestní sítě 
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Příloha 2 Opatření ke zpřístupnění pozemků, část 1 

Cesta kategorie dle  
ČSN 73 6109 

délka současný povrch odvodnění zem. 
pláně a vozovky 

živič. štěrk. trav. nezp. 

Ozn. - m bm bm bm bm - 

HPC1 hlavní 7/30 505 505 
   

svodný příkop 

HPC2 hlavní 4,5/30 1150 1150 
   

svodný příkop 

HPC3 hlavní 5/30 680 
 

680 
  

příčný sklon 

HPC4 hlavní 4,5/20 914 
 

914 
  

příčný sklon 

VPC1 vedlejší 4/30 1970 
 

1970 
  

příčný sklon 

VPC2 vedlejší 4/30 1294 
 

1294 
  

svodný příkop 

VPC3 vedlejší 4,5/30 1150 
   

1150 - 

VPC4 vedlejší 3,5/30 1192 1192 
   

příčný sklon 

VPC5 vedlejší 5/20 522 
   

522 - 

VPC6 vedlejší 3,5/20 613 613 
   

- 

VPC7 vedlejší 4/20 410 
  

410 
 

svodný příkop 

VPC8 vedlejší 4,5/30 223 223 
   

příčný sklon 

DPC1 doplňková 2/20 981 
  

981 
 

svodný příkop 

DPC2 doplňková 3/30 609 
 

609 
  

svodný příkop 

DPC3 doplňková 3/30 1605 
 

1605 
  

svodný příkop 

DPC4 doplňková 3/30 537 37 
  

500 - 

DPC5 doplňková 3/30 124 
  

124 
 

svodný příkop 

DPC6 doplňková 3/30 679 679 
   

příčný sklon 

DPC7 doplňková 3/30 207 207 
   

příčný sklon 

DPC8 doplňková 3/30 1024 
   

1024 svodný příkop 

DPC9 doplňková 2/- 699 
  

699 
 

- 

DPC10 doplňková 3,5/30 92 92 
   

příčný sklon 

DPC11 doplňková 3/30 856 56 
 

800 
 

- 

DPC12 doplňková 3/30 357 
   

357 - 

DPC13 doplňková 3/30 382 
  

382 
 

- 
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Příloha 3 Opatření ke zpřístupnění pozemků, část 2 

Cesta propustky 
žlaby 

hosp. 
sjezdy 

mosty výsadby doplňující informace 

Ozn. ks ks ks - - 

HPC1 
   

ano příkop k revitalizaci 

HPC2 2 
  

ano 
 

HPC3 
   

ne 
 

HPC4 
   

ne 
 

VPC1 
  

1 ano 
 

VPC2 1 1 1 ano 
 

VPC3 
   

ne dobudovat příkop 

VPC4 1 
  

ne 
 

VPC5 
   

ne k rekonstrukci 

VPC6 
   

ne dobudovat příkop 

VPC7 1 
  

ne 
 

VPC8 
   

ne 
 

DPC1 
   

ne 
 

DPC2 
   

ano 
 

DPC3 1 
  

ano 
 

DPC4 
   

ne dobudovat příkop 

DPC5 1 
  

ne 
 

DPC6 
   

ne 
 

DPC7 
  

1 ano 
 

DPC8 
 

1 
 

ne 
 

DPC9 
   

ne 
 

DPC10 
   

ne 
 

DPC11 
  

1 ano 
 

DPC12 1 
  

ne 
 

DPC13 
   

ano 
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Příloha 4 Erozní ohroženost půdy – stav 
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Příloha 5 Erozní ohroženost půdy – návrh 
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Příloha 6 Současná vodohospodářská opatření 
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Příloha 7 Současný ÚSES 
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